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CircuitPro PL 3.5 User interface

License level Basic

The license level Basic of the software provides the basic functions for using the
system. If a function is not available, the following message is displayed:

Operation not allowed in this edition

o Create path is not allowed in Basic edition, only in an advanced edition -
Contact the LPKF sales departrent

Fig. 1: Message Operation not allowed in this license level

License level Advanced

In the license level Advanced, the following functions are available in addition to the

basic functions:

e Templates for non-laminated materials as well as multi-layers and ProMask
templates

e Importing DXF files

e Multiply the layout with Step and repeat and create instance types

e Functions in the user guidance step Layout for creating and editing objects.

e Automatic fiducial creation

V. 1.1 | LPKF Laser & Electronics AG 9/184
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1 User interface

The user interface of your system software is divided in individual panes that can be
shown or hidden as required. Additionally, you can move, minimize, and arrange the
panes according to your needs. Thus, the user interface is variable and possibly

structured differently.

Workdiow setup
Material composition
4 Layout

Fiducials
Scan fields
Tools 3
Toolpaths
Processing
Navigat 2
== T (e L ol
’} === Al
|
| !
H M
| 6
|
|
155
1S
N

7 —
File Edt Inset Layout Toolpaths Processing Service { 1
) H Qe R —

New Material Import Layout Scanfields Tools Workflow Toolpaths _ Processing

rrors

Camera

o013 2

F /& md I & )

Scan felds >

The following table describes the individual areas of the user interface:

No. | Name

Description

1 Menu bar and toolbar

Contains menu items and provides fast access to frequently
used functions.

2 User guidance steps

Contains several user guidance steps (New, Import, Layout,
etc.), that guide you through the process.

3 Pane Workflow setup

Contains information on the tools, the scan fields, and other
structures of the work file.

4 Toolbar View

Contains functions for displaying the objects.

5 Views

Contains a two-dimensional view of the workpiece that can
be zoomed. Contains several switchable views with different
functions.

6 | Pane Navigation

Contains information on the objects or the current position.

Pane Properties

Contains several panes with information on objects or the
current position.

7 Pane Fault monitor

Contains a list of all errors.

Pane Messages

Contains a list of messages.

Table 1:  User interface

LPKF Laser & Electronics AG | V. 1.1
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1.1 Pane Workflow setup

The pane Workflow setup contains information on the currently loaded processing
data such as layer, scan fields, used tools, etc.

Most of the entries contain functions that can be activated via the context menu.

Worlflow setup

I Material composition
I Layout

I Scan fields

I Tools

I Workflow

I Toolpaths

I Processing

q

Fig. 3: Pane Workflow setup

The entries of the pane Workflow setup are described in the following table:

Name Description

Material composition Displays several information on the material set.

Layout Displays the existing objects, fiducials, and apertures.

Scan fields Displays the existing scan field sets and the computed
scan fields.

Tools Displays the existing tools and the tools that are assigned
to the project.

Workflow Displays the active and inactive work packages and the
order of processing.

Toolpaths Displays the computed toolpaths of the individual tools.

Processing Displays the order how the active work packages are
processed.

Table 2: Pane Workflow setup

V. 1.1 | LPKF Laser & Electronics AG
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1.1.1 Material composition

This section of the Workflow setup displays the existing layers according to the

material surface.

Waorkflow setup

4 Material composition
[» = FR4 1,5 mm 18 pm
I Layout
I Scan fields
4 Tools
4 = FR4 15 mm 18 pm
b (& Drill Fiducials
b @ Drill Material
b (J Cut Material
b @ Isolate
b @ PreCut
I ( Divide Strip
b (J Hatch
b @ Heat
b @ Short Heat
I Workflow
I Toolpaths

I Processing

Fig. 4: Pane Workflow setup | Material composition

LPKF Laser & Electronics AG | V. 1.1
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1.1.2 Layout

This section of the Workflow setup contains information on the different layers of the
processing data and the contained objects.

Workflow setup

Material composition
4 Layout

4 Layers

B[] BoardOutline (1)
b [T DriliPlated (64)

b [ TopLayer (2309)
rh . BottomLayer (106)
rh |:| Contour Cutting (2)
b [ Dvill Plated Drills (2)
rh . Top Insulate (4)

B[ | Top Hatch (2)

b Il Top Heat (2)

b [ Top ShortHeat (2)
rh . Top PreCut (1)

rh . Bottom Insulate (4]
b [ | Bottom Hatch (2)
rh . Bottom Heat (2)

b I Bottom ShortHeat [2)
rh . Bottomn PreCut (1)

4 Imported files
Tutor.BOA_1 (CAProgram Files (x86)\LPKF Laser Electror
Tutor.BOT_1 (C:\Program Files (x86)\LPKF Laser Electror
Tutor. TOP {C:\Program Files (x86)\LPKF Laser Electronic
Tutor.DRL_1 (C\Pragram Files (xB6)\LPKF Laser Electron

Fig. 5:

The entries of the section Layout are described in the following table:

Pane Workflow setup | Layout

Name Description

Layers Contains all existing layers.
Apertures Contains all existing apertures.
Instances Contains all existing instances.
Fiducials Contains all existing fiducials.
Table 3: Pane Workflow setup | Layout

In the context menu, specific functions of the individual items are available. Right-click
to open the context menu.

V. 1.1 | LPKF Laser & Electronics AG
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The entries of the context menu are described in the following table:

Section/ltem Name Description

Layers Add layer Adds a new layer.

Selected layer Color... Changes the color of the objects within a
layer in the view CAM.

Visible Shows/Hides the layer in the view CAM.

Selectable Disables/Enables editing objects within
the selected layer.

PCB layer Assigns the layer to a PCB layer.

Display mode Sets how the objects are displayed in the
view.

e Thin line: Displays the objects as
thin line.

e Contour: Displays the objects as
contour.

e  True width: Displays the objects in
their true width.

Technology Assigns a technology to the layer. The
selected technology determines which
tools can be used.

Inverse Structures the source layer from the
inside. Example: In a letter or a number
the inner area is structured.

Rename Renames the selected layer.

Delete Deletes the selected layer.

Selected instance

Edit instance type

Opens the dialog Edit instance type.

Dissolve instance type

Dissolves the selected instance type.

Selected fiducial

Edit fiducial

The selected group is reimported.

Configure search strategy...

Opens the dialog Configuration of search
strategies.

Copy search strategy to

Assigns the search strategy of the
selected fiducial to another fiducial.

Assign to layer

Allows you to assign the fiducial to the
layer Fiducial.

Table 4;

Context menu Layout

LPKF Laser & Electronics AG | V. 1.1
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Configuring search strategy
Opens a dialog to configure a search strategy.

Summary

Configuration of search strategies

Plausibility/Verification

[]: Confirm every fiducial

[] i the nominal distance is greater than

Improve accuracy

Center if distance to center is greater than | 0,500 mm

Fallback

1. Use the spiral search in the search area 3,000 mm

2. Use the manual search

Use as default Cancel

Use the Configuration of search strategies dialog to define the further procedure when
the fiducial search finds no valid hits.

You can set several parameters that determine which hits are valid.
Plausibility/Verification

Enable this function to determine the behavior if the hit shall lie outside the set
distance. In this case, the search can either be performed manually or canceled.

Improve accuracy

If this function is enabled, and the distance is greater than the set distance, the
processing head moves over the target and the camera is focused again. This results
in a better recognition of the fiducial but requires more time.

Fallback

If a fiducial is not located at the expected position, a spiral search can be performed in
the defined area. This runs within a square spiral from the inside out while the search
area is checked for valid hits. If no fiducial has been, a manual search can be
executed as a last possibility.

V. 1.1 | LPKF Laser & Electronics AG 15/184
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1.1.3 Scan fields
This section of the Workflow setup displays the existing scan fields.

Worlflow setup

Layout
Toolpaths
+ Scan fields

Processing

Material composition

Scanfeld 1 (Bottom Side)
Scanfeld 2 (Bottom Side)
Scanfeld 3 (Bottom Side)
Scanfeld 1 (Top Side)
Scanfeld 2 (Top Side)

i1

Fig. 6: Pane Workflow setup | Scan fields

The entries of the section Scan fields are described in the following table:

Name

Description

Scan field

Scan field name with consecutive numbering.

Table 5: Pane Workflow setup | Scan fields

In the context menu, specific functions of the individual items are available. Right-click
to open the context menu.

The entries of the context menu are described in the following table:

Section/ltem Name Description
Scan fields Compute Computes all scan fields.
Create scan fields Opens a dialog for creating a new scan
field set.
Scan field Compute Computes the scan fields based on the

selected scan field set.

Table 6: Context menu Scan fields

LPKF Laser & Electronics AG | V. 1.1
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114 Tools

This section of the Workflow setup contains information on the different tools and their

tasks.

Waorkflow setup

4 Material composition
[» = FR4 1,5 mm 18 pm
I Layout
I Scan fields
4 Tools
4 = FR4 15 mm 18 pm
b (& Drill Fiducials
b @ Drill Material
b (J Cut Material
b @ Isolate
b @ PreCut
I ( Divide Strip
b (J Hatch
b @ Heat
b @ Short Heat
I Workflow
I Toolpaths

I Processing

Fig. 7: Pane Workflow setup | Tools
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1.1.5 Workflow

This section of the Workflow setup contains information on the work packages of the
project. The work packages combine various information such as layers, tools, scan
fields and technology and enable computing the toolpaths.

There are predefined work packages that already use the existing layers, tools and
scan fields. If you are using customized data for your own layout, you should edit the
work packages or create new ones.

Workflow setup n

i Material composition
I Layout
I Scan fields
I Tools
4 Workflow
4 1. Top Side
|:| 1. Mount Material
[ ] 2. Drill Fiducials
1 3. Orill Through Holes
D 4, Structure Top
b 7] 5. Cutting Group
|:| 6. Dismount Material
2. New phase 1
I Toolpaths
I Processing

Fig. 8: Pane Workflow setup | Workflow

In the context menu, specific functions of the individual items are available. Right-click
to open the context menu.

The entries of the context menu are described in the following table:

Section/ltem Name Description
Workflow Add production phase Creates a new production phase.
Phase Computing toolpaths Computes the toolpaths for the assigned
layers and scan fields.
Work package Cut The selected work package is removed
and copied into the clipboard.
Copy Copies the currently selected work
package into the clipboard.
Activated Activates/Deactivates the work package
during production.
Process Starts processing the selected work
package.
Process all Starts processing the selected phase.
Rename Renames the work package.
Delete Deletes the work package.

Table 7: Context menu Workflow

LPKF Laser & Electronics AG | V. 1.1
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1.1.6 Toolpaths

This section contains the computed toolpaths and their assigned work packages and
tools. The toolpaths are used to show the movements of the processing head and to
implement them during processing of the material.

Worldflow setup

I Material composition

I Layout

I Scan fields

I Tools

I Workflow

4 Toolpaths

4 1 Top Side

[ ’Isulatfun [Structure Top]
[ <> Hatching [Structure Top]

I Processing

i

Fig. 9: Pane Workflow setup | Toolpaths

1.1.7 Processing

This section contains the work steps that are executed during production. These work
steps comprise the loading and unloading process and the active work packages. The
work packages can be processed as sorted either by tool or by scan field.

Workflow setup

I Material composition
I Layout
I Scan fields
I Tools
I Workflow
I Toolpaths
4 Processing
4 1. Top Side
|:| 1. Mount Material
[ ] 2. Drill Fiducials
1 3. Drill Through Holes
E 4. Structure Top
b [T 5. Cutting Group
|:| B. Dismeunt Material

i1

Fig. 10:  Pane Workflow setup | Processing

In the context menu, specific functions of the individual items are available. Right-click

to open the context menu.

V. 1.1 | LPKF Laser & Electronics AG
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The entries of the context menu are described in the following table:

Section/ltem Name

Selected processing side

Check tool settings Opens a dialog for checking the current tool
settings.

Table 8: Context menu Processing

1.2 Toolbar View

The toolbar View is a vertical bar that is available for all views. Depending on the view,
the available functions can vary.

The toolbar View contains the following icons/functions:

Icon Name Description
+ . Selects a rectangular area by drawing with the mouse. All
Selection : -
objects inside are marked.

Moves the visible area of the processing data within the
| Pan view by dragging with the mouse. This can also be
activated by pressing the mouse wheel (if present).

Zooms into the selected area.

e H Zoom area
| . Displays the whole layout. The view Processing displays
= > Fit all .
| the whole processing area.
=y Polygonal Marks objects by drawing a polygon.
— selection
Show grid Shows/Hides the grid.
Sna to arid Defines whether operations can only be used on grid
plog points. This works also when the grid is hidden.
* . Defines whether the mouse cursor can only be snapped
L] Snap to object e )
to certain points on an object.

Defines that the mouse pointer is snapped to a specific
Snap to angle angle when selecting a second point. Additional angles
can be configured under Snap to in the options.

Table 9: Toolbar View

In the view Camera the following functions are available:

Icon Name Description

) Shows the crosshair in the camera view.
Crosshair overlay

with circle

Crosshair overlay | Shows the crosshair with rectangle in the camera view.

'45' Crosshair overlay | Shows the crosshair with circle in the camera view.
-¢- with rectangle

Table 10: View Camera

LPKF Laser & Electronics AG | V. 1.1
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1.2.1 Selection
Selects objects and elements within the view.

Summary

The selection allows to select individual objects and several objects at the same time.

Fig. 11:  Select objects

Fig. 12:  Objects selected (hatched white)

It is important for selection whether the selection rectangle is opened from top to
bottom or from bottom to top.

Selection from top to bottom: Only those objects are selected that are completely
within the selection rectangle.

Selection from bottom to top: All objects are selected that are (partly) within the
selection rectangle.

V. 1.1 | LPKF Laser & Electronics AG 21/184
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1.2.2 Pan
Moves the entire displayed area by clicking and dragging the mouse.

You can also move the displayed area by clicking and dragging the mouse in the pane
Navigation.

Fig. 13: Pan

1.2.3 Zoom area

Selects a rectangular area by drawing with the mouse. The selected area is zoomed
in.

Fig. 14: Zoom area

Fig. 15:  Area zoomed in

LPKF Laser & Electronics AG | V. 1.1
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1.2.4 Fitall

Changes the displayed area so that all existing objects in the layer are completely
displayed.

The function [Fit all] shows in the user guidance step Processing the entire processing
area.

Fig. 16:  Fitall

1.2.5 Polygonal selection

Selects an area by clicking and drawing a polygon with the mouse. The marked
objects within the polygon are selected.

Marks objects by drawing a polygon.

Fig. 17:  Polygonal selection

V. 1.1 | LPKF Laser & Electronics AG 23/184
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Fig. 18: Polygons selected

1.2.6 Show grid
Shows/Hides the grid in the workpiece view.

The function [Snap to grid] can also be used when the grid is hidden.

_'_

Fig. 19:  Hide grid

Fig. 20:  Show grid
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1.2.7 Snap to grid
Defines whether objects can only be created/moved on grid points.

[Snap to grid] is not working when the grid is hidden.

Fig. 21:  Cursor (white crosshairs) on grid point

1.2.8 Snap to object
Defines whether the mouse cursor can only be snapped to certain points on an object.

In File > Options > General > Snap you can make further settings for the function
[Snap to object] in the tab Snap to object.

1.2.9 Snap to angle
Defines that the mouse cursor is only snapped onto angles.

In File > Options > General > Snap you can make further settings for the function
[Snap to angle] in the tab Snap to angle.
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1.3 Menu bar and toolbar

The pane Menu bar and toolbar contains important main functions of the software.

File Edit Inset Layout Toclpaths Processing Service

[ | [Q & )

Fig. 22:  Menu bar and toolbar

The functions of the menu bar and toolbar are described in the following table:

Icon Name Description

Create new project file Navigates to the user guidance step New. You can start a
D based on a template new project there.

Open existing project file | Displays the file system where you can open an existing
project file.

Save current project file | Saves the current project file in the file system.

ol

Print preview Displays a print preview of the current layout.

Print layout Opens a dialog to configure the print settings.

Cut selected objects Cuts all selected objects and places them into the
clipboard.

Copy selected objects Copies all selected objects into the clipboard.

Paste objects from Pastes all objects from the clipboard into the project.
clipboard

Undo last action Undoes the last action performed.

Redo last action Redoes the last action undone.

V(S| | X ||

Delete selected objects | Deletes all selected objects.

Table 11: Menu bar and toolbar
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1.4 Pane Fault monitor

The pane Fault monitor contains a list of all active faults. These can refer for example
to error messages during workpiece production or to a problem while starting the

system.
Fault monitor 2
Fault Time Fault Description Accept time  Fault Code

Fig. 23:  Pane Fault monitor

The icons/functions are described in the following table:

Icon Name Description
Accept all Starts the troubleshooting procedure. All errors not yet
/ acknowledged are acknowledged automatically.
x Clear all Deletes all errors from the list that have already been
acknowledged.

Table 12: Pane Fault monitor

The items of the pane Fault monitor are described in the following table:

Name Description

Fault time Displays the time and date when the error occurred.
Fault description Displays a detailed description of the error that occurred.
Accept time Displays the time when the error was acknowledged.
Fault code Displays the corresponding fault code.

Table 13: Items of pane Fault monitor

V. 1.1 | LPKF Laser & Electronics AG 27/184



User interface CircuitPro PL 3.5

1.5 Pane Messages

The pane Messages contains a list of all system messages. These are divided into
Errors, Warnings, Messages, and Service messages.

Messages

60 Errors ! 0 Warnings o 0 Messages 0 Service messages

Message Referenced objects Time (descending) Status

Fig. 24: Pane Messages

The areas of the pane Messages are described in the following table:

Name Description

Fault Errors are critical system software errors. The errors can
be displayed or hidden by clicking on Errors.

Warnings Warnings are due to input errors that the user has
caused. For example, these can be information on
canceled actions or actions that have not been executed
properly and that can cause a restricted program
operation.

The warnings can be displayed or hidden by clicking on
Warnings.

Messages Messages present statistical information of the system
software. These can be feedback of the system software
on certain actions that have been executed.

For example: New document created

The messages can be shown or hidden by clicking on
Messages.

Service messages Service messages are displayed when maintenance of
the system is due. Contact the LPKF service. The service
messages can be displayed or hidden by clicking on
Service messages.

Table 14: Pane Messages
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1.6 Pane Navigation

The pane Navigation displays the object to be processed in small format. The zoomed
area in the view CAM is marked in the pane Navigation (1). By keeping the left mouse
key pressed, the marked area can be moved.

Navigation

Fig. 25: Pane Navigation

1.7 Pane Properties

The pane Properties contains information on the loaded processing data. Depending
on the selected entry in the pane Workflow setup, different information is displayed.

Properties
File name <not saved>
Underlying template PL-U4_DoubleSided_NoTHP.cp2d
Version 3.0.166.0
Is modified flag True
4 Objects
Algorithms 6
Aperture lists a1
BRep shapes 0
Conductors 2480
Groups 0
Layers 32
Text objects 0
Taolpaths 0
Tools 11
Document

Fig. 26: Pane Properties
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2 User guidance steps

The user guidance steps guide you through the process within the application. In order
to ensure a safe process, you will be guided from the data preparation to the layout
adjustment and to the production, if necessary. You have always the possibility to
switch between the user guidance steps.

New Material Import Layout Scanfields Tools Workflow Toolpaths Processing Camera

Fig. 27:  User guidance steps and Camera view

The user guidance steps are described in the following table:

Name Description

New Creates a new project or opens an existing project.

Material User guidance step for selecting and defining the
processing material.

Import Imports selected files. These are displayed in the view of
the user guidance steps Layout, Scan fields, and
Toolpaths.

Layout User guidance step for editing the processing data. You
can create or edit objects here.

Scan fields User guidance step for computing and arranging the scan
fields.

Tools User guidance step for creating new tools and editing the

tool parameters.

Workflow User guidance step for activating/deactivating and
adapting the work packages. In this user guidance step,
you can also assign the work packages to process groups
and instance types.

Toolpaths User guidance step for computing the toolpaths.

Processing User guidance step for processing the material based on
the computed toolpaths and scan fields.

Camera This view can show the images of both cameras.
Furthermore, the processing head can be moved
manually.

Table 15: User guidance steps
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21 New

In the user guidance step New, already existing projects or templates can be opened.
In addition, the recent projects are displayed.

Recent projects
Stitching_U4
us

ple Trade Show

Stitching_S4

Open project...

Recent templates
$4_SingleSided_Top
$4_DoubleSided_NoTHP
U4 _DoubleSided NeTHP

U4 SingleSided_Top

Open template...

New  Material Import Layout Scanfields Tools Workflow Toolpaths  Processing Camera

$4_BlLayer_GalvanicTHP_MultipressS

~
All materials v | pLua v [ Supported by ProteMat

PCB with Top layer, prepared for Protolaser U4

LPKF templates
Single-sided, Top, Protolaser U4
Double-sided, ProtoLaser U4, no threugh-hele plating
Double-sided, ProtoLaser U4, galvanic through-hole plating
Double-sided, ProtolLaser U, EasyContac
Double-sided, ProtoLaser U4, ProConduct
4 Layers, ProtoLaser U4, galvanic through-hole plating
4 Layers, ProtoLaser U4, galvanic through-hole plating, MultiPress §
4 Layers, ProtoLaser U4, galvanic through-hole plating, MultiPress S, b
4 Layers, ProtoLaser U4, ProConduct
4 Layers, ProtoLaser U4, ProCenduct, MultiPress §
6 Layers, ProtoLaser U4, galvanic through-hole plating
& Layers, ProtoLaser U4, galvanic through-hole plating, MultiPress §
6 Layers, ProtoLaser U4, galvanic through-hole plating, MultiPress S, b
8 Layers, ProtoLaser U4, galvanic through-hole plating
2 Layers, ProtoLaser U4, galvanic through-hole plating, MultiPress §
8 Layers, ProtoLaser U4, galvanic through-hole plating, MultiPress S, b
Stencil for ProtoPrint, ProtoLaser U4

Stencil for ProtoPrint, short version, Protolaser U4

Load template Material >

Fig. 28:

User guidance step New

The buttons are described in the following table:

Button

Description

Recent projects

Shows the projects that have been used most recently.

Recent templates

Shows the templates that have been used most recently.

Supported by ProtoMat

Displays only the templates that are supported by ProtoMat,
when activated

Open project

Opens a selection to search for a project in the folder system.

Open template

Opens a selection to search for a template in the folder system.

Load template

Loads the currently selected template from the list and switches
to the user guidance step Material.

Material

Closes the currently opened dialog and switches to the user
guidance step Material.

Table 16: User guidance step New
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2.2 Material

In the user guidance step Material you can define the processing material with its
properties and select existing material profiles.

FR4

FR4

ML104

ML104

L 4 Mew

== Single-sided

L AL203_Au22
Single-sided, 0,5 mm, 22 pm
Cu Foil on 15400 prepreg
Single-sided, 0,08 mm, 3 um

Single-sided, 1,5 mm, 18 ym

G Y

Material name FR4

Treat as non-laminated

conper N v

Single-sided, 1,5 mm, 35 pm
Core

Single-sided, 0.2 mm, 18 pm

Single-sided, 0,2 mm, 5 pm

Total thickness

Import ¥

Fig. 29:

User guidance step Material

The icons/functions of the dialog Material are described in the following tables:

Icon

Name

Description

All materials

Material type

Selects the material list and only displays materials of a
certain type.

Ik

Duplicate material

Duplicates the selected material.

X

Remove material

Deletes the selected material from the list.

E

Export material

Exports the selected material with its properties into the
file system.

5]

Import material

Imports a material from the file system.

Button Discard Removes all unspecified materials from the list.
Button Save Saves a new created material in the drop-down list.
. Selects the material that has been marked with a left-
Button Select material click
Continues with the current settings and navigates to the
Button Import

user guidance step Import.

Table 17: User guidance step Material
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2.3 Import

In the user guidance step /mport you can import various file formats.

The following formats are supported:

Format Description Extension

BOA Native file formats *.boa

BOT *.bot

DRL *.drl

TOP *.top

CAM Native file format *.cam

CP2D Native file format for CircuitPro projects cp2d

Excellon File formats for drilling and milling PCBs. *.drl; *.drd

Gerber File format for PCB image files *.gbr

Gerber X, Enhanced file format for PCB image files *.gbx

Gerber X2

HPGL File format for drawings, formerly used for | *.plt
operating pen plotters

DXF File format for drawings from the AutoCAD | *.dxf

Sieb & Meyer File formats for drilling and milling PCBs. *.drl

*.sm1; *.sm2

Table 18: Import formats

New Material Import Layout Scanfields Tools Workflow Toolpaths Processing Camera
i ~
O [*open =2
———
- ) [ 1 « ExempleData » UseCase_DoubleSidedPCE [ 43 |[ Search UseCase DoubleSided... O
Organize v New folder = 0O @
T= -
<2 e * Name Date modified
I Favorites
B Desktop [# Template_DeubleSided_NoTHP_PM-PL_ProtoLaserS.chf f
& Downloads [ Template DoubleSided_NoTHP_PM-PL_ProtolaserU3.chf [
&l Recent Places L] TutorBOA £
[ TuterBOT i
= Libraries 2| [ TutorDRL !
| Documents | Tuter.TOP 1
& Music
[&] Pictures
B videos
v
% Computer
&L, (€ Local Disk
y - »
€ May e - . Layout 2»
Messages File name: - [Allfiles ) M *
Message ing) Status
Fig. 30:  User guidance step Import

The icons and buttons are described in the following table:

Icon Name Description
|_-L| Opens a drop-down list for importing files from the
Add
folder system.
El- Discard Removes the selected file.
= Run ATE Starts the ATE (aperture template editor).
Button Discard Removes the selected file.
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Icon Name Description
Import Imports the selected file and displays it in the user
Button P guidance step Layout.

After importing the desired files, the view is changed as follows:

Tuter.BOA | GerberX IZ| | BoardApe E
Source Target Size/Format
BoardQutline BoardQutline v | 80,632 x 45,72 mm

Tutor.BOT GerberX [v] [ Botape [¥]
Source Target Size/Format
Gerber data BottomLayer W 166,42 x 34,003 mm

Fig. 31:  File import

The following information of the imported files is displayed:

Column Description

File name Displays the name of the file to be imported:

Format Displays the format of the imported file.
If the format is not recognized correctly, you can correct
the format in the drop-down list.

Source Indicates the names of the paths/3D elements within the
imported file.

Target Displays the layer to be assigned.

Size/Format

Displays the size/format of the layer.

Table 19: File import

The user guidance step Import contains the following tabs:

2D

Shows the design and the dimensions of the imported file:

2D ‘ Apertures/Tools

w
o

LN
w
=

|-21,E=Cl ||J.U
[ WA MWW

| Text | Messages |

2180

Tab 2D
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Apertures/Tools

Displays a list of apertures and tools that you need for your imported project:

2D Apertures/Tools Text Messages
Image Name Mode Rotation | a b c d
[ O Jow ] o= Joa | | | |

Fig. 33:  Tab Apertures/Tools

The columns have the following meaning:

Column Description

Image Displays the shape of the aperture.

Name Displays the name of the aperture.

Mode Displays whether the aperture has been imported as a drawn object or
as a flash |W|

Rotation Displays whether the aperture is rotated (circular apertures have 0° as
default).

a-d Show parameters that describe the size of the aperture. Depending on the
aperture shape, not all parameters are necessary.

Table 20: Tab Apertures/Tools
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Text

Displays the ACSII text of the imported file:

2D | Apertures/Tools | Text Wessages

PoFSLAX23Y23*%
%MOMM*%
%ADD10C,0.100000%%
%LNBoardOutline*%
%LPD*%

G54D10*
X21749Y-38974D02%
X-21740Y-38974D01*
X-21749Y38974D01%
X21749Y38074D01*
X21749Y-38974D01%
M02*

Fig. 34: Tab Text

Messages

Displays system messages about executed operations:

2D | Apertures/Tools l Text ‘ Messages ‘

Message

Preview was built in 0,108 s.

Preview was built in 0,065 s.
Preview was built in 0,068 s.
Preview was built in 0,068 s.
Preview was built in 0,056 s.
Preview was built in 0,075 s.
Preview was built in 0,032 s.

Data was loaded from
Data was loaded from
Data was loaded from
Data was loaded from
Data was loaded from
Data was loaded from
Data was loaded from

. ..

[ <

"C:\Users\edd\Documents\LPKF Laser Electronics\LPKF CircuitP
"C:\Users\edd\Documents\LPKF Laser Electronics\LPKF CircuitP
"C:\Users\edd\Documents\LPKF Laser Electronics\LPKF CircuitP
"C:\Users\edd\Documents\LPKF Laser Electronics\LPKF CircuitP
"C:\Users\edd\Documents\LPKF Laser Electronics\LPKF CircuitP
"C:\Users\edd\Documents\LPKF Laser Electronics\LPKF CircuitP
"C:\Users\edd\Documents\LPKF Laser Electronics\LPKF CircuitP

Import assignment found for "C:\Users\edd\Documents\LPKF Laser Electronics\LPKF (
Import assignment found for "C:\Users\edd\Documents\LPKF Laser Electronics\LPKF ( S

ve  memaas “oien AT - BT U2 o

>

Fig. 35:

Tab Messages

36/184

The dialog Import contains the following sub tabs, depending on which tab (2D,

Apertures/Tools, Text, or Messages) is active:
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File

Displays the measurements of the imported file:

File Format
Unit
Walues

Decimal

Digits m.n

Fig. 36:  Sub tab File

The following settings are possible:

Setting Description
Unit Specifies the measurement unit (millimeters or inches).
Values Specifies whether absolute or relative values are used.
Decimal Specifies whether leading or trailing zeroes are to be suppressed.
Digits m.n Specifies the number of decimal places of the coordinates:
m = places before the decimal point
n = decimal places

Table 21: Sub tab File
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Format

Provides various options:

File Format

| Use layer name

| Use layer polarity

|| Rotate square in movement direction
|| Step and repeat to flash

[ ] Rotate AM-Octagon

|| Set 360 interpolation as default

¥] Ignore “mirrored” property

|| Apply to all Gerber files

Fig. 37:  Sub tab Format

The following settings are possible:

Setting

Description

Use layer name

Activates/Deactivates using the layer names defined in the Gerber
file.

Use layer polarity

Activates/Deactivates the analysis of the layer polarity during
Gerber import.

Rotate square in
movement direction

Activates/Deactivates the automatic rotation of square objects
during Gerber import.

Step and repeat to flash

Combines object collections to flash objects for step-and-repeat
commands in the file.

Rotate AM-Octagon

Always aligns octagon edges to axes.

Set 360° interpolation as
default

Activates the 360-degree interpolation for circles as default,
regardless of corresponding commands in the file.

Ignore “mirrored” property

Ignores the property “mirrored” during import.

Apply to all Gerber files

Applies the settings to all imported Gerber files.

Table 22: Sub tab Format
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Attributes

Is only displayed when the tab Apertures/Tools is active and shows the properties of
the apertures and tools:

General Options | Attributes

Type: _ Circle EI
Rotation: 0
a 3 mm l
b:

c

d:

Fig. 38:  Sub tab Attributes
The following settings are possible:

Attribute Description

Type Specifies the type of the aperture. The type can be changed via the drop-
down list.

Rotation Displays/Specifies the rotation of the aperture. Manual changes are possible.

a-d Show parameters that describe the size of the aperture. Depending on the
aperture shape, not all parameters are necessary.

Table 23: Sub tab Attributes
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B Importing CAD da
1. Click on [

ta

2. Inthe dialog that is displayed, select the data for import.

New Import Layout Scanfields Tools Workflow Toolpaths Processing Camera
T 8
¥ o =
Look in UseCase_DoubleSidedPCB - @F = m-
T Name Date modified Type
""y Tamplate_DoubIeSided_N oTHP_PM-PL_Pro... 24.04.2018 01:00 CircuitPro
RecentPlaces [0 Template_DoubleSided_NoTHP_PM-PL_Pro... 24.04.2018 01:00 CircuitPro
- || Tuter.BOA 24042018 01:00 BOA File
| Tuter.BOT 24042018 01:00 BOT File
Desktop | Tuter.DRL 24.04.2018 01:00 DRL File
— | Tutor.TOP 24042018 01:00 TOP File
Libraries
LY
Computer
&
,
A < I r
Network
Fils nisme [Folder Selection - Open
Files oftype: [Arfies (-9 -] [ cancel | v

Fig. 39:

3. Click on [Open].

User guidance step Import

O The following contents are displayed in accordance with your imported file (in this

case a Gerber file):

| LPKF_Drilling.ghx | Gerberx [v ][ Lok _Driling.gb [v] ~ | Fie [ Format .
i Source Target Size/format Unit

Contour_ThroughCut_Flex 1 Contour_ThroughCut_Flex_1 v | 166.437 ¥ 165.997 mm -

alues
SolderMaskBottom SolderMaskBottom ~ |166.046 x 165.444 mm
SolderMaskTop SolderMaskTop v 137159 x 40.077 mm Decimal
Toplay: ™
Toplayer oplayer 318102 x 20902 mm v Digits m.n 2 3

Fig. 40:  File import

4. Check the imported data. If necessary, assign the associated layers.

5. In the navigation ba

r click on [Import].

O The CAD data are imported and displayed in the view of the user guidance step

Layout.

|Zl The CAD data have been imported.
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24 Layout

In the user guidance step Layout, you can edit existing or imported data and generate

new objects.

File Edit Inset Loyout Toolpaths Processing Semvice

i H R & ©

]

Workflow setup )

New Material Import Layout Scanfields Tools Workflow Toolpaths Processing

Camera

> Material composition
< Layout

b Layers

I Apertures

& £

Instances
Fiducials
b Scan fields
b Tools
b Workflow
b Toolpaths
© Processing

R

[
&

FEEES

X=  624%mm VY=

fulmeones [f][Ons [

14,48 mm 0

F - omPBET &0 g

Scan fields 3

o | Messoges

Referenced objects Time (descending) Status

Fig. 41:

User guidance step Layout

Icons with a small triangle (see following figure) can open a context menu with a right-
click. It contains additional related functions.

O)

The icons/functions of the toolbar are described in the following tables.

Icon

Name

Description

B s

Selected layer

Displays the currently selected layer. You can change this
by opening a drop-down list with a left-click and selecting
a different layer from the list.

Displays the currently selected aperture. Left-click to

Rectangle path

—tne  [v] Apertgre open the drop-down list and change the aperture by
selection .
selecting another one.
Flash Creates a flash based on the aperture currently selected.
Path Creates a path in the current layer.
Polygon Creates a polygon in the current layer.
Creates a filled rectangle in the current layer.
Rectangle

Creates a rectangle path in the current layer.

Circle by
diameter

Creates a filled circle by defining a diameter.

Circle by points

Creates a filled circle by setting three points.

Ot J-2Inl B ARN

Circle path by
diameter

Creates a circle path by defining a diameter.

V. 1.1 | LPKF Laser & Electronics AG
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Icon Name Description
G Circle path by Creates a circle path by setting three points.
a / points
EE Create Data Creates a Data Matrix code

Matrix code

Create text object

Creates a text object. Subsequently, new functions for
modifying text are available.

Fiducial

Creates a new fiducial.

g |4 | |8

Automatic fiducial
creation

Opens a dialog automatic fiducial creation.

y
A, )

i
[T

Create fiducial
with defaults

Creates a fiducial with the default camera settings.

ra
LJd
rara
LJdLd

Create instance
type...

Creates an instance type from the selected objects where
the objects are used as the primary instance.

Rotate

Rotates one or multiple objects around a definable pivot
point.

g @

Move object

Moves the marked object by a defined distance and
direction.

Mirror horizontal

Mirrors one or multiple objects around the horizontal axis
of reflection (x axis).

=

Mirror vertically

Mirrors one or multiple objects around the vertical axis of
reflection (y axis).

Scales up or scales down the marked object by the scale

- Scale
¥ W factor.
Increases or decreases the marked object by a definable
Expand
length.
R Rounds the corners of the marked object.
ound
Chamfers the corners of the marked object.
Chamfer
M Merges adjoining or overlapping objects to a single
erge ) .
geometrical object.
. Removes the area of a geometrical object that is
Difference -
overlapped by a second selected object.
Split Splits a marked object by using a predefined path.
Add point Adds a point on a marked line.

Add mirror point

Adds two points with the same distance from the
reference point.

Moves a marked point.

Move point

Split path Splits the marked line segment of a path.
Convert to Fills a marked closed path.

polygon

M b (o o8 (3T (ab || T |ED

Convert to closed
path

Removes the filling of filled objects.
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Icon Name Description
@ Group Groups marked objects.
II—_-J Ungroup Ungroups grouped objects.
Show/Hide Shows/Hides the processing area.

processing area

Context menu

Step and Repeat

Opens a dialog for multiplying the selected objects. Can
be accessed via right-click in the user guidance step.

Context menu

Invert selection

Inverts the selection of objects in the 2D view.

Context menu

Close open path

Closes marked, open paths.

Context menu

Convert to flash

Converts drawn objects to flash objects and create new
apertures

Context menu

Explode flash

Converts the flash into an object.

Context menu

Compare to flash

Compares the marked flash with objects on the same
layer. Objects of the same shape are converted into a
flash.

Context menu

Assign to layer

Opens a view of the existing layers. Thus, the selected
object can be assigned to a specified layer.

Context menu

Copy to layer

Opens a view of the existing layers. Thus, the selected
object can be copied to a specified layer.

Context menu

Create aperture

Creates an aperture. In the user guidance step Layout the
new tab Aperture is displayed.

Select by Marks all objects that refer to the selected aperture.
Context menu

aperture
Context menu Select by Marks all objects with similar properties.

geometry

Context menu

Select by layer

Marks all objects of the same layer.

Context menu | Measure Measures the distance between two points.
Context menu | Cancel Closes the current function.
Button Import Opens the user guidance step Import.
Button Scan fields Opens the user guidance step Scan fields.

Table 24: User guidance step Layout

241 Flash

Creates a flash based on the aperture currently selected.

Summary

Use the function [Flash] to create a flash on the basis of the apertures in the aperture
library. If no aperture is selected the first aperture in the library is used.

The flash is assigned to the currently selected layer.
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2.4.2 Path
Creates a path in the current layer.

Summary

Apply the [Path] function to create open and closed paths in the user guidance step
Layout. These paths are automatically assigned to the currently selected layer and
use the selected aperture or path. Only circular apertures can be used for paths.

To close a path, you must create the last point, then select [Close open path] in the
context menu. The paths are automatically connected to close the shape.

= s00000mm fy=  125.000mm

Fig. 42:  Creating a path

243 Polygon
Creates a polygon in the current layer.

Summary

Use the function [Polygon] to create polygons in the user guidance step Layout. These
polygons are automatically assigned to the currently selected layer. The individual
lines can be created as straight lines or as arcs. Once the element is finished, it is
filled automatically.

Open the context menu and click on [Finish] or press to close the polygon.

Fig. 43: Create polygon
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244 Rectangle
Creates a filled rectangle in the current layer.

Summary

Use the function [Rectangle] to create filled rectangles in the user guidance step
Layout. The objects are automatically assigned to the currently selected layer.

Fig. 44:  Creating a rectangle

2.4.5 Rectangle path
Creates a rectangle path in the current layer.

Summary

Use the function [Rectangle path] to create rectangle paths in the user guidance step
Layout. The objects are automatically assigned to the currently selected layer.

Fig. 45:  Creating a rectangle path
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2.4.6 Circle by diameter
Creates a filled circle of a defined diameter.

Summary

With [Circle by diameter] you can create circles in the user guidance step Layout. After
creation, the circles are automatically filled and assigned to the currently selected
layer.

Fig. 46:  Creating circle by diameter

2.4.7 Circle by points
Creates a filled circle by setting three points.
Summary

Use the function [Circle by points] to create circles in the user guidance step Layout.
After the circles have been created, they are automatically filled and assigned to the
currently selected layer.

Fig. 47:  Creating a circle by points

2.4.8 Circle path by diameter
Creates a circle path by the defined diameter.

Summary

With [Circle path by diameter] you can create circle lines in the user guidance step
Layout. Once created, the circle paths are automatically assigned to the active layer.

Fig. 48: Creating circle path by diameter
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2.49 Circle path by points
Creates a circle path by setting three points.

Summary

Use the function [Circle path by points] to create circle paths in the user guidance step
Layout. After the circle paths have been created, they are automatically assigned to
the active layer.

Fig. 49:  Create circle path by points

2.410 Create Data Matrix code
Creates a Data Matrix code in the current layer

Summary

Use the function [Create Data Matrix code] to create a 2D code in a rectangular matrix
in the user guidance step Layout. This code can be read using a camera.
The Data Matrix codes are automatically assigned to the currently selected layer.

Specify DMC position

Fig. 50:  Create Data Matrix code
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With the functions in the right toolbar, variable contents can be displayed as Data
Matrix code. These values are not static but are adjusted at a certain point in time.
Click on == to add a variable of a specific data format (Number, Text, or Date).
Variables of the format Number can be additionally assigned a type (Serial number,
Batch, or Lot). Click on ™ to insert the variable into the text field.

Dynamic chjects a
MNumbers v
Type SenalNumber =
Description Serial number
Length 9
Initial value 1

Reset each batch []

Text W

Description | Text 1

Length 20

Date W

Example 2020/06/29

Date yyyy/ MM/ dd v

Fig. 51:  Settings for Data Matrix code with dynamic contents

Name Description

Number

Defines the type of the variable. You can select one of

the following types:

e  Serial number
At the start of each production, the serial number is
incremented by one value. If there are several serial
numbers and the length is changed, this value
changes for all serial numbers.

e Batch
The value is incremented by 1 when the maximum
number of serial numbers (length) has been
reached.

e Lot
Indicates the number of fully produced batches. The
value is incremented by 1 when the maximum

Type
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Name Description
number of batches has been reached.
Description Defines the description of the variable.
Defines the maximum number of digits for this variable.
Length Example:
At a length of 3 the maximum value is 999.
Initial value Defines the initial (starting) value of the variable.

Reset each batch

Activates/Deactivates resetting the count after each
batch.

Batch size

Defines the maximum batch size. A batch has been
produced, when the maximum serial number has been
reached.

Reset each lot

Activates/Deactivates resetting the count after each
batch.

Defines the maximum lot size. A lot has been produced,

Lot size when the maximum batch size has been reached.
Text

Description Defines the description of the variable.

Length Defines the maximum character length of the variable.
Date

Example Ejgclgj ]?c)r;rﬁ:?mple of the date according to the
Date Defines the format used for displaying the date.

Table 25: Functions for dynamic Data Matrix codes
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2.4.11 Create text object
Creates a text object in the current layer.

Summary

Use the function [Create text object] to create text objects in the user guidance step
Layout. In addition to conventional texts and numbers, the text objects can also
contain the serial number, the current date, and variables.

The texts are automatically assigned to the currently selected layer.

Fig. 52:  Create text

'.h . ToplLayer (2309) | v Segoe Ul v 3Imm B I T

Fig. 53:  Toolbar Create text object

Icon Name Description

Displays the currently selected layer. You can
W o] | Selected layer change this by opening a drop-down list with a left-
click and selecting a different layer from the list.

Displays the currently selected font. You can
- | Font change this by opening a drop-down list with a left-
click and selecting a different font from the list.

Displays the currently selected font size. Enter the

3mm | |Font size desired value for the font size into the input field.

Displays the currently selected text in bold letters.

B Bold

I ltalic Displays the currently selected text in italics.
Displays th tl lected text tline.

T Outline isplays the currently selected text as an outline

— Aligns text objects to the left of the input field.

— _  |Left

- Aligns text objects to the center of the input field.

Rl Center

- Aligns text objects to the right of the input field.

_— Right

Table 26: Functions Create text object
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With the functions in the right toolbar you can insert variable contents into the text

object. Their values are not static but are adjusted at a certain point in time. Click on
to add a variable. Variables of the format Number can be additionally assigned a

type (Serial number, Batch, or Lot). Click on ™! to add the variable into the text field.

Dynamic ohjects a
Numbers w
Type SerialNumber v
Description Serial number
Length 9
Initial walue 1
Reset each batch []
Text v
Description | Text 1
Length 20
Date v
Example 2020/06/29
Date yyyy/MM/dd v
Fig. 54:  Settings for text objects with dynamic contents
Name Description
Number
Defines the type of the variable. You can select between
the following types:
e  Serial number
At the start of each production, the serial number is
incremented by one value. If there are several serial
numbers and the length is changed, this value
changes for all serial numbers.
Type e Batch
The value is incremented by 1 when the maximum
number of serial numbers (length) has been
reached.
e Lot
Indicates the number of fully produced batches. The
value is incremented by 1 when the maximum
number of batches has been reached.
Description Indicates the description of the variable.
Defines the maximum number of digits for this variable.
Length Example:
At a length of 3, the maximum value is 999.
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Name

Description

Initial value

Defines the initial (starting) value of the variable.

Reset each batch

Activates/Deactivates resetting the serial number after
each batch.

Batch size

Defines the maximum batch size. A batch has been
produced, when the maximum serial number has been
reached.

Reset each lot

Activates/Deactivates resetting the count after each lot.

Defines the maximum lot size. A lot has been produced,

Lot size when the maximum batch size has been reached.

Text

Description Specifies the description of the variable.

Length Indicates the maximum character length of the variable.
Date

Example sngclgj ]?c)r;rﬁ:?mple of the date according to the

Date Defines the format used for displaying the date.

Table 27: Functions for dynamic text objects

When adding dynamic objects, the user guidance step Layout only displays example

values.

2.4.12 Fiducial

Displays a fiducial at the cursor position. Left-click to determine the center of the

fiducial and to create the fiducial.

Summary

The total size of the fiducial can be defined by the diameter in Options >
Miscellaneous> Fiducial > Diameter.
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2.4.13 Automatic fiducial creation
Opens a dialog for automatic fiducial creation.

Summary

The dialog Automatic fiducial creation allows you to change the settings for the
automatic fiducial creation.

creation

Fiducials auto set

Switch on the required fiducial buttons for autoematic

2
3 4
Position style Highest accuracy v
Distance 4 rmm
Source layer BoardCutline hd
Delete fiducials | Mothing hd

Fig. 55: Dialog Automatic fiducial creation

The following settings are available:

Name

Description

1,2,3,4

Selects the fiducials that are to be created automatically.

Position style

Selects the criterion according to which the fiducials are to be placed.
Highest accuracy: The fiducials are placed in a way that they can be
captured with high accuracy in the camera image.

Material efficient: The fiducials are placed so that the material is
optimally used.

Distance

Indicates the (outer) distance between source layer and fiducials in x
andy.

Source layer

Indicates the layer where fiducials are to be created.

Delete fiducials

Selects how to handle existing fiducials.

None: The existing fiducials remain.

All: All existing fiducials are deleted.

Overlapping: Remaining fiducials that are automatically overlapping
due to automatic creation are deleted.

Table 28: Dialog Automatic fiducial creation
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2.4.14 Create fiducial with defaults
Creates a fiducial with standard camera settings.

Summary

To change standard values, open the user guidance step Camera and click [Library].
Select the entry marked as Standard and adopt the current camera settings by using
[Apply] or [OK].

2.4.15 Create instance type...
Creates an instance type with the selected objects as a primary instance.

Summary

An instance type consists of a primary instance and at least one instance. Instances
are references to the primary instance. The primary instance is produced at the
position of the individual instance during processing.

Subsequent changes to the primary instance are applied only partially. Once you
remove an object, this is applied immediately to the instance. If you want to add new
objects, you have to dissolve the instance type and create it anew with the added
objects

The fiducials contained in the primary instance are created as local fiducials and are
also multiplied during processing.

Fig. 56:  Instance type (with primary instance and three instances)

You have to assign an instance type to an instance group in the user guidance step
Workflow to be able to create toolpaths for it.

Instances provide several advantages over multiplied data (step and repeat):

e They require less memory. Thus, the data are loaded faster and their computation
is accelerated.

e Toolpaths are computed only for the primary instance and are reused for the
further instances. This accelerates the computation of the toolpaths significantly.
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The created instances are displayed in the pane Workflow setup:

Workflow setup

4 Material composition
= Material: 0 mm
4 Layout
[» Layers
[+ Apertures
4 Instances
4 Biilnstance type 1
. BottomLayer (8) [Rubout]
Fiducials
I Scan fields
I Tools
I Workflow
Toolpaths
I Processing

Fig. 57:  Workflow setup | Create instance type

2.4.16 Rotate

Rotates one or multiple objects around a definable pivot point.

Summary

The marked objects/contours are rotated around one point. Thereby, you choose the

position of the angle point and the rotation angle.

Fig. 58: Rotating an object/a contour
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2.4.17 Move object
Moves the marked object by a defined distance and direction.

Summary

Before moving, a reference point has to be specified. This point can also be located
outside of the marked object/marked contour or even be created on other
objects/contours. After the reference point is specified, the distance and direction can
be defined.

Fig. 59:  Moving an object/a contour

2.4.18 Mirror horizontal
Mirrors one or multiple objects around the horizontal axis of reflection (x axis).
Summary

The axis of reflection is located at the centroid of area of the selected object. If
multiple objects are selected, a common centroid of area is calculated that is used for
the reflection. The centroid of area can even be located outside of the objects.

Fig. 60:  Mirror object horizontal
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2.4.19 Mirror vertical
Mirrors one or multiple objects around the vertical axis of reflection (y axis).
Summary

The axis of reflection is located at the centroid of area of the selected object. If
multiple objects are selected, a common centroid of area is calculated that is used for
the reflection. The centroid of area can even be located outside of the objects.

Fig. 61:  Mirror object vertical

2.4.20 Scale
Scales up or scales down the marked object by the scale factor.

Summary

All lines of the object are scaled uniformly so they keep their shape even after
increasing/reducing the size.

Specify scaling coefficient
Scale coefficient =  PEIlY %

Fig. 62:  Scaling an object

2.4.21 Expand
Increases or decreases the marked object by a definable offset to the contour.

Summary

The marked object is increased or decreased uniformly around all sides. Increasing
the object can cause a significant change of the shape.

Fig. 63: Expanding an object

The function is only available if a single object is marked. Multiple objects cannot be
expanded at the same time.
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2.4.22 Round
Rounds the corners of the marked object.

Summary
You can determine the radius of the rounding and select the corners to be rounded.

There is a differentiation between the outer and the inner corners.

Fig. 864: Rounding corners

Outer angles have an angle that is smaller than 180° within the geometrical object.

Fig. 85: Outer angles

Inner angles have an angle that is greater than 180° within the geometrical object.

Fig. 66: Inner angles
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2.4.23 Chamfer
Chamfers the corners of the marked object.

Summary

You can determine the length of the sides to be chamfered and the angles to be
chamfered.

There is a differentiation between the outer and the inner angles.

Fig. 67: Chamfer angles

Outer angles have an angle that is smaller than 180° within the geometrical object.

Fig. 68: Outer angles

Inner angles have an angle that is greater than 180° within the geometrical object.

Fig. 69: Inner angles
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2.4.24 Merge
Merges adjoining or overlapping objects to a single geometrical object.

Summary
[Merge] is only available if at least two geometrical objects are marked.

Merged objects can only be restored to the previous state with [Undo].

+

Fig. 70:  Merge objects

The created object is assigned to the layer of the objects used. If the objects are
located on different layers, the newly created object is assigned to the upmost layer
used.

2.4.25 Difference

Removes the area of a geometrical object that is overlapped by a second selected
object.

Summary

[Difference] is only available if a filled object is selected. If the function is activated, a
second object has to be selected. The area where the objects are overlapping is
deleted.

After using this function, the second object is deleted by default. This setting can be
changed in the options.

Objects that have been edited with [Difference] can only be restored to the previous
state with [Undo].

- "

Fig. 71:  Difference
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2.4.26 Split
Splits a marked object by using a predefined path.
Summary

When splitting, the line located on the object to be split is drawn first. Later, this line
shall be used as a dividing line. Then select the object and enable the [Split] function.
Click the line to split the object at the position of the line.

Fig. 72:  Splitting an object

2.4.27 Add point
Adds a point on a marked line segment.

Summary

[Add point] is only available if a line or a point of a segment is marked.

Fig. 73:  Add point

2.4.28 Add mirror point
Adds two points with the same distance from the reference point.

Summary

[Add mirror point] is only available if a line or a point of a segment is marked.

Fig. 74:  Add mirror point
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2.4.29 Move point
Moves a marked point.

Summary

The marked point can be moved by using the mouse or by entering the relative
coordinates. Multiple points can be marked as long as they are within the same object.

Fig. 75:  Move point

2.4.30 Split path
Splits the marked line segment of a path.

Summary

The line segment can be split at the mouse position or by entering relative coordinates
referring to the center of the path or the selected point.

Fig. 76:  Split path

[Split path] cannot be used for filled objects.
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2.4.31 Convert to polygon
Fills a marked closed path.

Summary

[Convert to polygon] is only available if a closed path is marked.

Fig. 77:  Converting object to polygon

2.4.32 Convert to closed path
Removes the filling of filled objects.

Summary

[Convert to closed path] is only available for marked and filled objects.

Fig. 78:  Converting object to closed path

2.4.33 Group
Groups marked objects.

Summary

[Group] is only available if at least two objects are marked.

Fig. 79:  Group objects
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2.4.34 Ungroup
Ungroups objects.

Summary
[Ungroup] is only available if grouped objects are marked exclusively.

2.4.35 Show/Hide processing area
Shows/Hides the processing area.

Summary

The processing area is shown as blue square.

Fig. 80: Processing area
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2.4.36 Step and Repeat
Multiplies selected objects. The spacing and the number of instances can be set.

Summary

In the dialog Step and repeat, the fields Count and Distance can be used to define
how often and with what distance the copies are to be created. Different values for the
copies in the x- and y-direction can be entered.

Fig. 81:  Step and repeat

Step and repeat

Countx| ‘_| j,.'| 1‘

@ Distance

X 0,000 mm
y
¥ 0,000 mm  ian

) Offset

Preview

[1 Combine to flash list

OK || Cancel |

Fig. 82: Dialog Step and Repeat

Name Description

Count Shows the overall count of the objects in x and y direction
including the original data.

Distance Defines the distance between two created objects. The
length and width of the original data are used as the initial
values. If you do not change these values, the copies are
right next to each other. Higher values create a space
between the copies, lower values cause the copies to

overlap.
Offset Defines the offset between two created objects.
Preview Displays a preview of the objects to be created.
Combine to flash list Combines the original data to a flash list.

Table 29: Settings Step and Repeat
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2.4.37 Invert selection
Inverts the selection and selects all objects outside the selection area.

Summary

The selection is inverted and all objects outside the selection area are selected.

Fig. 83:  Selection area

Fig. 84:  Selection area highlighted

Fig. 85: Invert selection
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2.4.38 Close open path
Connects both end points of an open path with a line.

Summary

[Close open path] is only available if an open path is marked. The marked object is
converted to a closed path.

Fig. 86: Close open path

2.4.39 Convert to flash
Converts a marked object into a flash.

Apertures — Line ZI ¥ /@& 09T

Drill Plated Drills

Construct line [0 mm]

Fig. 87:  Converting an object into a flash

2.4.40 Explode flash
Converts the flash into an object.

2.4.41 Compare to flash

Compares the marked flash with objects on the same layer. Objects of the same
shape are converted into a flash.

Summary

Smaller deviations of the object’s size and angles can be adapted by entering
tolerance values in the dialog.
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2.4.42 Create aperture
Opens the view Aperture to create a new aperture.

Summary

The marked objects are displayed in the view Aperture and can be edited before the
aperture is saved.

Layout £ Apertures

— T F @m0

RSN
[

¥

=

X=  -0004mm Y= 002Imm 0

< Lo

Fig. 88: View Aperture

2.4.43 Measure
Measures the distance, starting from the selected position.

Summary

The selected position is used as the initial point for measurement. As soon as you
select another position, it is used as initial point for measurement.

4,387 mm

Fig. 89:  Measure from point to point
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2.5

Scan fields

In the user guidance step Scan fields you can compute scan fields for existing scan
field sets and arrange them automatically or manually.

R & +

o]
s

H D

X=

1229 mm Y=

New Material Import Layout Scanfields Tools Workflow Toolpaths Processing Camera
EEER T o

53,194mm 0

| Campute taolpaths H Compute scan fields

Fig. 90:

User guidance step Scan fields

Icons with a small triangle (see following figure) can open a context menu with a right-
click. It contains additional related functions.

O

The icons/functions of the toolbar are described in the following tables.

Icon

Name

Description

Common scan fields (7) | v

Selected scan field

Selects the scan field to be computed.

Compute scan fields

Computes the scan fields for the layers defined in the
scan field set.

Creating a scan field
set

Creates a new scan field set. At least one layer must
be assigned to the set.

Create scan field
manually

Allows you to create scan fields at the cursor position.

Move object

Moves the marked object by a defined distance and
direction.

Z|dmnaa

Special ProtoLaser
sorting

Arranges the order of the scan fields automatically
from the right upper side to the lower left side.

Ik

Meander sorting in x

Arranges the order of the scan fields from top to
bottom alternatingly in both x directions.

-

Meander sorting in y

Arranges the order of the scan fields from left to right
alternatingly in both y directions.

I

Spiral sorting inwards

Arranges the order of the scan fields in an inward
spiral.
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Icon Name Description
Spiral sorting Arranges the order of the scan fields in an outward
El outwards spiral.
“F Manual sorting of Defines the processing order of the existing scan
N scan fields fields by clicking on them.
BA Display scan fields Displays the numbering of the scan fields.
3 4]
E:Zl Compute all... ]E)omputes the toolpaths based on the existing scan
- ields.
./, Show/Hide the Shows/Hides the computed toolpaths.
e toolpaths

Display mode True | Shows the objects in their real dimensions. Filled
width objects are displayed as filled.

Shows the objects in their real dimensions. Filled

Display mode Outline objects are displayed only as paths.

Shows filled objects only as paths. Lines are

H Plsplay mode Thin displayed only as thin lines regardless of their actual
ine - ;
line width.
Show/Hide Shows/Hides the processing area.
@ processing area
Context menu | Step and repeat... Multiplies selected scan fields.
Button Computing toolpaths (}‘omputes the toolpaths based on the existing scan
fields.
Computing scan Computes the scan fields for the layers defined in the
Button fields scan field set.

Table 30: User guidance step Scan fields

2.51 Move object
Moves the marked object by a defined distance and direction.

Summary

Before moving, a reference point has to be specified. This point can also be located
outside of the marked object/marked contour or even be created on other
objects/contours. After the reference point is specified, the distance and direction can
be defined.

Fig. 91:  Moving an object/a contour

2.5.2 Compute all...
Computes the toolpaths based on the computed scan fields and work packages.
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2.5.3 Show/Hide processing area
Shows/Hides the processing area.

Summary

The processing area is shown as blue square.

Fig. 22: Processing area
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2.5.4 Step and repeat...

Multiplies selected scan fields. The spacing and the number of the multiplied scan
fields can be set.

Summary

In the dialog Step and Repeat, you can define in the fields Count and Distance how
many copies of the scan fields are created and the distance between them.

The values for the copies in x direction and y direction can be different. The objects
within the scan fields are not multiplied.

Step and repeat

Count x| 1‘ }r| 1|

@:Gap distance

o[ ogomm)
¥
J[omomm] I
X

D Offset
X 3,200 mm
¥ 3,200 mm
Preview
OK | | Cancel ‘

Fig. 93: Dialog Step and Repeat

2

Fig. 94:  Scan field multiplied with Step and Repeat
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2.6 Tools

In the user guidance step Tools, you can create and edit cutting, structuring, and
isolation tools. You have to define tasks for the individual tools. Assign different
parameter values to the tasks. These include:

e Drilling parameters

e Laser parameters

e Process parameters

e Common parameters

e Scanner parameters

LPKF CircuitPro PL 2019.1 - Advanced edition - Untitled[U4_SingleSided_Top] -0
File Edit Insert Layout Toolpaths Processing Semvice
\Worflow setup ?| New Material Import Layout Scan fields Tools Workflow Toolpaths Processing Camera
4 Material composition 5 -
= ALRO2 Au2205mm |V | | Dill Material Copy |v| @ [} © 8| 2 I THP
I == AI203_AUZ20,5 mm 22 pm = P €L R AR = X
= General} | Advanced
" Layout Bl tooltype  Diiling
I Scan fields = Drill parameters. ~
EE  Toolname | Drill Material Copy
4 Tools e W Sttesy Concene il [#
4 == AI203_Au220,5 mm 22 pm 5
Task1 »
b () Drill Fiducials Overlep 3um
3 DrillFiducials Copy 0,25 mm, 585 W, 45 kHz, 150 mmy/s, RT 160 Filling direction Outsidein v
b @ Drill Material
Inner remainder dizmeter 0pm
b & @ Drill Material Copy
b (3 Cut Material Mex.strip width 100 pm
b @& lsolate Laser parameters
b @ Precu Frequency | 45kHz Pulse energy 130
b (G Hatch
BT Power 585W
b Toolpaths Mark speed | 150 mm/s .
b Processing
€ Scan fields Worlflow >
Messages )
Qo Erors ! 0 Wanings @7 Messages
Message Referenced objects Time (descending) Status
Fault monitor | Messages

Fig. 25:  User guidance step Tools

Changes have to be saved with [Save] before switching to another user guidance
step.

The icons/functions of the toolbar are described in the following table.

Icon Name Description

@ Drilling tool Creates a new drilling tool.

[ _1 Cutting tool Creates a new cutting tool.

g\ Isolation tool Creates a new isolation tool.

% Hatching tool Creates a new hatching tool.

E}f\ Heating tool Creates a new heating tool.

:: Duplicate tool Creates a copy of the selected tool.

?:"- Remove tool Removes a tool copy.
S;g{og)d to the global Copies the local tool to the global catalog.
Through hole plating Opens the tab THP Settings.
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Icon Name

Description

Create new task

Creates a new task with the currently selected
tool.

: Duplicate existing task

Copies the currently selected task into the

clipboard.
Paste task Pastes a task from the clipboard.
E;\ Remove existing task Deletes the currently selected task.
) Navigates to the previous user guidance step
Button Scan fields Scan fields.
Button Discard Restores the state that was saved last. Any
u

changes that have not been saved are lost.

Button Apply

Saves the current settings.

Button Workflow

Navigates to the following user guidance step
Workflow.

Table 31: Symbols/Functions in the user guidance step Tools

General

The following table describes the tool and process parameters of the tab Advanced:

Name

Description

Laser parameters

Frequency Sets the pulse frequency of the laser in [kHz].
Power Sets the power of the laser in [W].
Mark speed Sets the mark speed of the laser in [mm/s].

Drilling parameters

Strategy Defines how the drill holes are processed. The following
strategies can be applied:
e Outline: The outline of the hole is processed.
e  Concentric fill: Several circle paths with the same center
but different radius are executed to fill the drill hole.
e  Spiral: The drill hole is filled with a spiraling movement.
Overlap Defines how far the laser beam overlaps the previous pass

when filling the drill holes.

Filling direction

Defines the processing direction of the fill. You can define
whether the drill holes are filled from the edge inwards or
from the center outwards.

Inner remainder diameter

Defines the inner remainder diameter of the circle in [um]. If
the value is 0, the circle area is processed completely. Any
higher value produces an area in the center of the circle that
is not processed.

Max. strip width

Shows the maximum strip width in [um].

Process parameters

Focused

Activates/Deactivates focusing.

Focus offset

Changes the height of the laser focus in addition to the
material height and table height. Changing this value may
cause the focus point to be no longer exactly on the
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Name Description
material.
Repetition Determines the number of repetitions of the task.
Delay Determines the length of the pause between two repetitions

of a task in [ms].

Use repetitions Defines how processing is repeated.
e Repeat each hole separately

e Repeat each hole in each repetition

Enable air flow Enables the air flow for the tool.

Table 32: Tool parameters | General

Advanced

The following table describes the parameters of the tab Advanced:

Name Description

Common parameters

Beam diameter Determines the beam diameter in [um].

Skywriting Activates the skywriting function. This computes the
toolpaths in such a way that the start moves (blue) and end
moves (green) are outside the paths to be processed. This
causes a slight increase in processing time.

Polygon mode Activates the skywriting function not only for starting and
leaving the toolpath but also for structuring corners.

Scanner parameters

Jump speed Sets the maximum speed of the jump movements in [mm/s].

Jump delay Defines the delay to be compensated for a jump in [us].

Laser on delay Determines the delay of the laser source that is to be
compensated at the start of a structuring in [ps].

Laser off delay Determines the delay of the laser source that is to be
compensated at the end of a structuring in [us].

Mark delay Determines the delay to be compensated for the drag error
in [us].

Polygon delay Determines the delay of the laser source that is to be

compensated for polygons in [us].

Table 33: Tool parameters | Advanced
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2.7

Workflow

In the user guidance step Workflow you can create and activate the work packages.
Furthermore, you can arrange them in production groups and instance groups. These
allow a more precise configuration of the processing order.

New Material Import Layout Scanfields Tools Workflow Toolpaths Processing Camera
Bottom Side | ¥ | Ty [
[ | '
Mount Material Bottom 9 Read Fiducials Bottom 9 Structure Bottom % Top Side
Work package options —————————————
Activated
MName Mount Material Bottom
Type Instruction v
Instruction | Meunt material bottom v
Mount the material with the side
Bottom facing upwards onto the
Message processing area.
€ Tools Toalpaths
Fig. 96:  User guidance step Workflow
The icons/functions of the user guidance step Workflow are described in the following
tables.
Icon Name Description
Ty Add phase Adds a new workflow phase.

Add work package

Adds a new work package behind the current
selection. In the work package, the tool or the action
for the task can be selected. The following actions and
tools are available.

— Instruction

—  Drilling

— Read fiducials
—  Expose fiducial
— Cutting

—  Structuring

Group work
packages

Groups the selected work packages to a processing
group.

Ungroup work
packages

Ungroups the selected processing group.

Process selected
objects

Processes the selected objects.

Stop processing

Stops the current processing.

%

Compute toolpaths

Computes the toolpaths of the processing group /of
the work package.

Button

Tools

Navigates to the user guidance step Tools.

Button

Discard

Restores the state that was saved last. Any changes
that have not been saved are lost.
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Icon Name Description
Button Save Saves the current settings.
Button Compute toolpaths (;omputes the toolpaths based on the existing scan
fields.
Button Toolpaths Navigates to the user guidance step Toolpaths.

Table 34: User guidance step Workflow

The different types of work packages are explained in the following.

The following table describes the functions of the work package Instruction:

Name Description
. Activates/Deactivates the work package. Deactivated work packages
Activated . ;
are not executed during production.
Name Indicates the name of the work package.
Defines the type of the work package. The type of the work package
Type . . . -
determines which tools and functions are available.
. Assigns a suitable instruction from a predefined list to the work
Instruction
package.
Message Displays an additional explanation for the instruction.

Table 35: Work package type Instruction

The following table describes the functions of the work package Dirilling:

Name

Description

Activated

Activates/Deactivates the work package. Deactivated work packages
are not executed during production.

Test tool settings

Enables/Disables checking the tool settings.

Name Indicates the name of the work package.
T Defines the type of the work package. The type of the work package
ype . . .
determines which tools are available.
Tool Defines the tool that will be used for processing the active input
layers.
Displays the layers that can be processed with the selected tool.
Input layer These must be set to the appropriate technology. Only active layers

are processed.

Scan field set

Displays the scan field set that is used.

Table 36: Work package type Drilling
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The following table describes the functions of the work package Read fiducials:

Name Description
Name Indicates the name of the work package.
Type Defines the type of the work package. The type of the work package

determines which tools are available.

Scan field set

Displays the scan field set that is used.

Dynamic alignment

Selects up to four fiducials from the drop-down list. Depending on the

Fiducial number of fiducials, different transformations (e.g. move, rotate and
scale) can be applied.
Scales the layout data for processing based on the fiducials or based
Scale on a fixed factor (in x and y direction). The original data are not

modified, only processing is modified based on these values.

Table 37: Work package type Read fiducials

The following table describes the functions of the work package Expose fiducials:

Name

Description

Activated

Activates/Deactivates the work package. Deactivated work packages
are not executed during production.

Test tool settings

Enables/Disables checking the tool settings.

Name Indicates the name of the work package.
Defines the type of the work package. The type of the work package
Type : . .
determines which tools are available.
Tool Defines the tool that will be used for processing the active input
layers.
Displays the layers that can be processed with the selected tool.
Input layer These must be set to the appropriate technology. Only active layers

are processed.

Scan field set

Displays the scan field set that is used.

Table 38: Work package type Expose fiducials
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The following table describes the functions of the work package Cutting:

Name

Description

Activated

Activates/Deactivates the work package. Deactivated work packages
are not executed during production.

Test tool settings

Enables/Disables checking the tool settings.

Name Specifies the name of the work package.
Tvoe Specifies the type of the work package. The type of the work package
yp determines which tools are available.
Tool Defines the tool that will be used for processing the active input
layers.
Displays the layers that can be processed with the selected tool.
Input layer These must be set to the appropriate technology. Only active layers

are processed.

Scan field set

Displays the scan field set that is used.

Parameters

Position

Specifies whether processing has to be performedinside, Outside, or
at the Center.

Channel width

Specifies the channel width in [um].

Target beam overlap

Specifies the target value of the beam overlap in [%].

Actual beam overlap

Indicates the actual value of the beam overlap in [%].

Sorting

Selects between the sorting methods Inside out and Outside in.

Unidirectional

If this check box is checked, sorting can only be performed in one
direction.

Tabs position

Selects between the following tab positions:
—  NoGaps

— Indefinite

— Corners

— AllSides

— VerticalSides

—  HorizontalSides

Tab width

Indicates the tab width in [mm].

Distance

Indicates the distance in [mm].

Table 39: Work package type Cutting
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The following table describes the functions of the work package Structuring:

Icon/Name Description
Isolate
Input layer Selects from a list the layers to be processed with the tool /solate.

Isolation width

Indicates the isolation width in [um].

Pad isolation

Indicates the pad isolation in [um].

Target beam overlap

Specifies the target value of the beam overlap in [%)]. 0% means no
beam overlap.

Actual beam overlap

Indicates the actual value of the beam overlap in [%].

Isolation distance scan

field to scan field

Specifies the isolation distance between the scan fields.

Printed circuit board

Restrict by PCB
boundaries

Activates/Deactivates a boundary for structuring.

Outline layer

Specifies the layer that contains the outline of the printed circuit
board.

Hatching

Generate

Activates structuring.

Hatching layer

Specifies the layer where the hatching is to be generated.

Pattern

Selects the pattern according to which the hatching is to be
generated.

Hatching grid

Specifies the hatching grid in [um].

Use pre-cut lines for
scan fields

Activates/Deactivates using pre-cut lines for scan fields.

Align to global grid

Activates/Deactivates the alignment to the global grid. This ensures
that toolpaths are structured in parallel, e.g. in case of overlapping
scan fields.

Hatching contour
overlap

Specifies the overlap of the contour when hatching. 0% means no
overlap.

Tools

Adds a new tool.

Inserts a production splitter between the tools.

Deletes the selected tool.

Drop-down list

Selects between the following tools:
— Isolate

— Hatch

— Divide

—  Heat

—  ShortHeat
—  PreCut

Table 40: Work package type Structuring
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A processing group is created with the function [Group] when at least two work
packages are selected.

Name

Description

Group options

Activates/Deactivates the work packages within a processing group.

Activated Deactivated processing groups are not executed during processing.
Name Defines the name of the processing group to be computed.
Specifies the sorting method for the processing group. A scan field
oriented processing causes the scan field to be completely processed
Sorting policy with all tools. A tool oriented processing causes all scan fields to be

processed with the current tool. Only when all scan fields have been
processed with this tool, processing continues with the next tool.

Table 41: Processing group options

2.7.1 Computing toolpaths

Computes the toolpaths of the production group/of the work packages.
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2.8 Toolpaths

In the user guidance step Toolpaths, you can compute the toolpaths for existing work
packages and edit the points on the toolpaths.

New Material Import Layout Scanfields Tools Workflow Toolpaths Processing Camera
7 / o

X= 0694mm ¥=  55074mm 0

€ Workflow | Compute scanfields || Compurte taolpaths

Fig. 97:  User guidance step Toolpaths

Icons with a small triangle (see following figure) can open a context menu with a right-
click. It contains additional related functions.

O

The icons/functions of the toolbar are described in the following tables.

Icon Name Description
Zy/l Compute all Computes the toolpaths based on the existing scan
| P fields and work packages.
Display mode True Shows the objects in their real dimensions. Filled
“ width objects are displayed as filled.
. .| Shows the objects in their real dimensions. Filled
H| Display mode Outline | ~, . X
objects are displayed only as paths.
Display mode Thin S.hows filled objects.onlly as paths. Lines are
E line displayed only as thin lines regardless of their actual
line width.
. Show jump lines Shows/Hides the jump lines of the computed
- toolpaths.
Work packade Selects a work package. New toolpaths are created in
P 9 the selected work package.
Show/Hide work Shows/Hides all objects in the view that are in the
D package work package.
Tool Selects a tool. New toolpaths are created with the
Ocuing V] selected tool.

Create toolpath Creates a toolpath.

Moves the selected object by a defined distance and
direction.

Rotates one or multiple objects around a definable
pivot point.

/
F.? Move object

Rotate

Mirrors one or multiple objects around the horizontal

Mirror horizontally axis of reflection (x axis).

|
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Icon

Name

Description

Mirror vertically

Mirrors one or multiple objects around the vertical axis
of reflection (y axis).

Add point

Adds a point on a selected line.

Add mirror point

Adds two points with the same distance from the
reference point.

Move point

Moves a selected point.

Split path

Splits the selected line segment of a path.

Combine paths

Combines two paths.

Show/Hide scan
fields

Shows/Hides the scan fields.

b (BB AN o [of |30 a0 |

Show/Hide
processing area

The processing area is shown/hidden.

Navigates to the previous user guidance step

Button Workflow Workflow
Combpute scan fields Computes the scan fields for the layers defined in the
Button P scan field set.
Button Compute toolpaths Qomputes the toolpaths based on the existing scan
fields.
Button Processing Navigates to the following user guidance step

Processing.

Table 42: User guidance step Toolpaths

2.81

Compute all...
Computes the toolpaths based on the computed scan fields and work packages.

2.8.2 Show jump lines
Displays the laser jump lines of the computed contour.

Summary

The resulting jump movement of the laser is a positioning movement from one point to
be processed to the next point to be processed. In the meantime, the laser is switched

off.

Fig. 98:

Show/Hide jump lines
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2.8.3 Create toolpath
Creates a toolpath in the current layer.

Summary

You can use the function [Create toolpath] to create toolpaths in the user guidance
step Toolpaths. The objects are automatically assigned to the currently selected layer.

Specify distance
X= 0,000mm gy = 0,216 mm

ST mm

Fig. 99:  Create toolpath

2.8.4 Move object
Moves the marked object by a defined distance and direction.

Summary

Before moving, a reference point has to be specified. This point can also be located
outside of the marked object/marked contour or even be created on other
objects/contours. After the reference point is specified, the distance and direction can
be defined.

Fig. 100: Moving an object/a contour
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2.8.5 Rotate
Rotates one or multiple objects around a definable pivot point.

Summary

The marked objects/contours are rotated around one point. Thereby, you choose the
position of the angle point and the rotation angle.

Fig. 101: Rotating an object/a contour

2.8.6 Mirror horizontal
Mirrors one or multiple objects around the horizontal axis of reflection (x axis).
Summary

The axis of reflection is located at the centroid of area of the selected object. If
multiple objects are selected, a common centroid of area is calculated that is used for
the reflection. The centroid of area can even be located outside of the objects.

Fig. 102: Mirror object horizontal
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2.8.7 Mirror vertical
Mirrors one or multiple objects around the vertical axis of reflection (y axis).
Summary

The axis of reflection is located at the centroid of area of the selected object. If
multiple objects are selected, a common centroid of area is calculated that is used for
the reflection. The centroid of area can even be located outside of the objects.

Fig. 103: Mirror object vertical

2.8.8 Add point
Adds a point on a marked line segment.

Summary

[Add point] is only available if a line or a point of a segment is marked.

Fig. 104: Add point
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2.8.9 Add mirror point
Adds two points with the same distance from the reference point.

Summary

[Add mirror point] is only available if a line or a point of a segment is marked.

Fig. 105: Add mirror point

2.8.10 Move point
Moves a marked point.

Summary

The marked point can be moved by using the mouse or by entering the relative
coordinates. Multiple points can be marked as long as they are within the same object.

Fig. 106: Move point

V. 1.1 | LPKF Laser & Electronics AG 87/184



User guidance steps CircuitPro PL 3.5

2.8.11 Split path
Splits the marked line segment of a path.

Summary

The line segment can be split at the mouse position or by entering relative coordinates
referring to the center of the path or the selected point.

Fig. 107: Split path

[Split path] cannot be used for filled objects.
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2.9 Processing

LPKF CircuitPro PL 2019.1 - Basic edition - Untitled[S4_SingleSided_Top] - g
File Edit Insert Layout Toolpaths Processing Service
0 H @& & 9
okl e " New Material Import Llayout Scanfields Tools Workflow Toolpaths  Processing Camera
> Material composition .
b Layout ¥ % & <& % | &
I Scan fields —
| Sean S  sepe
b Werkflow " 0,500 mm
 Toolpaths .
4 Processing Q\' AN Step size.
I 1. Top Side ] —— | 0500mm
o) \
x| 10,000 mm
y [ 2so0mm | 4
z 0,000 mm
X= 97413mm V= 177109mm 0 7 FR4 15 mm 18 pm
€ Toslpaths Start production Camera >
Properties g || Messages k3
4 Dokument ~|| €30 Errors | 2 Wamnings @ 38 Messages
Lorme Message Referenced objects Time (descending) Status A
S~ ) The project data have been centered on the material area. 11:18:09.56
File name @ Projektdaten wurden auf dem Materialbereich zentriert. 11474331
Location of the document L i IDmJektda!en ‘wurden auf dem Materialbereich zentriert. 11:16:57.07
“Dle Null-Luft-Filter befinden sich innerhalb der Grenzen fur einen normalen Betrieb. 11:14:54.64 ~
Properties | Camera Fault monitor | Messages
Fig. 108: User guidance step Processing
The icons/functions of the toolbar are described in the following tables:
Icon Name Description
Process all Starts processing the
toolpaths and work packages.
. Stop processing Stops the current processing.
| Activate pilot laser Activates the pilot laser.
Activate the laser Activates the laser during
production. Material can only

be processed while the laser
is activated. Deactivating the
laser can be used for

measuring production times.

Pid Switch on/off the extraction Switches the extraction
system system on and off.
b Move the system to the Moves the system to the
=] loading position loading position.
m: Create instance type Creates an instance type from

the selected objects where the
objects are used as the
primary instance.

"i._:] Placement... Opens a dialog where the
I settings for placing the
processing data in the
processing area can be

adjusted
Y Automatic fiducial creation Opens a dialog for automatic
i fiducial creation.
: Special ProtoLaser sorting Sorts the order of scan fields
lf : in the specific ProtoLaser
sorting.
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Icon

Name

Description

Meander sorting in x

Arranges the order of the scan
fields from top to bottom
alternatingly in both x
directions.

-

Meander sorting in y

Arranges the order of the scan
fields from left to right
alternatingly in both y
directions.

[y

Spiral sorting inwards

Arranges the order of the scan
fields in an inward spiral.

Spiral sorting outwards

Arranges the order of the scan
fields in an outward spiral.

-1

Manual sorting of scan fields

Defines the processing order

EN" of the existing scan fields by
clicking on them.
./ Show/Hide information layer | Shows/Hides the objects that
i are on the information layer.
t./ Power measurement Opens the dialog Power
Y measurement.
Button Toolpaths Navigates to the user
guidance step Toolpaths.
Button Start processing Starts the processing of the
toolpaths and work packages.
Button Camera Navigates in a submenu to the

view of the Camera.

Table 43: User guidance step Processing
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Tab Navigation

You can use the functions in the tab Navigation to move the processing point manually
in x and y direction.

Clicking on the following buttons moves the processing point in x and y direction. The
processing point is moved in the entered step size which can be adjusted as well.

_;”'-Li N, Step size
(40 ») | 0500 mm

A

(4

Fig. 109: Moving in x and y direction

Clicking on the following buttons moves the processing point in z direction.

T, Step size

Ny

-~
y

|I ‘ I|
—— | 0500 mm

Fig. 110: Movement in z direction

Using the button '€|5‘.§. you can move the processing point to the position entered in the
fields x, y, and z. The current zero point is used as reference point (0, 0, 0) for this.

x| 100414 mm

y | su6mm | 5

z 0,000 rmm

Fig. 111: Positioning to x, y, and z value

2.9.1 Process all
Starts the production of all processing data.

2.9.2 Stop processing
The current processing procedure is stopped.
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2.9.3 Create instance type...
Creates an instance type with the selected objects as a primary instance.

Summary

An instance type consists of a primary instance and at least one instance. Instances
are references to the primary instance. The primary instance is produced at the
position of the individual instance during processing.

Subsequent changes to the primary instance are applied only partially. Once you
remove an object, this is applied immediately to the instance. If you want to add new
objects, you have to dissolve the instance type and create it anew with the added
objects

The fiducials contained in the primary instance are created as local fiducials and are
also multiplied during processing.

Fig. 112: Instance type (with primary instance and three instances)

You have to assign an instance type to an instance group in the user guidance step
Workflow to be able to create toolpaths for it.

Instances provide several advantages over multiplied data (step and repeat):

e They require less memory. Thus, the data are loaded faster and their computation
is accelerated.

e Toolpaths are computed only for the primary instance and are reused for the
further instances. This accelerates the computation of the toolpaths significantly.
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The created instances are displayed in the pane Workflow setup:

Workflow setup a

4 Material composition
= Material: 0 mm
4 Layout
[» Layers
[+ Apertures
4 Instances
4 %5 Instance type 1
. BottomLayer (8) [Rubout]
Fiducials
I Scan fields
I Tools
I Workflow
Toolpaths
I Processing v

Fig. 113: Workflow setup | Create instance type
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29.4 Placement...
Opens the dialog Placement for rotating and moving the processing data.

The dialog Placement allows correct placement of the material. Once the toolpaths
and scan fields have been generated, the tab Processing data is also displayed.

Placement =

Material

Click into the processing area to move the active head to the associated
position. Use the buttons to set the left front and right rear corner of the

raterial.
| [ ]
¥ 000,5 mm x 3055 mm
y 0180 mm y  247,0 mm
Width | 305mm | Length | 229 mm Set default size

Use a caliper to measure the material thickness

Material thickness 0,522 mm IMeasure matenal thickness

0K Cancel

Fig. 114: Dialog Placement

The button [Measure material thickness] starts the automatic measurement of the
material thickness. This function is used for unconventional material thicknesses and
is only available if the required sensor is present in the system.

The following functions are available in the tab Material:

Name Description
Material
Width Specifies the width of the material.
Length Specifies the length of the material.
Set default size Resets the width and length to the initial value.
Material thickness Specifies the material thickness.
Measures the thickness of the material. You can
. . find more settings for the thickness measurement
Measure material thickness . . . :
in the menu Processing under Material thickness
measurement setting.

Table 44: Dialog Placement | Tab Material
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Material Processing data

Use information layers
Processing head
Center on data

Show bounding bax

Placement -

Drag and drop the bounding box of data in the processing view.

Center of processing data  x y

Angle 0°

132,53 mm

L

Center an material

Cancel

Fig. 115: Dialog Placement | Tab Processing data

The following functions are available in the tab Processing data:

Name

Description

Center of processing data

Specifies the center of the processing data in x
and y direction.

Angle

Rotates the processing data by a definable angle.

Use information layers

Takes the information layers into account when
placing the processing data.

Center on material

Positions the processing data on the center of the
material.

Processing head

Center on data

Positions the processing head at the center over
the machining data.

Show bounding box

Shows the bounding box of the processing data.

Table 45: Dialog Placement | Tab Processing data
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2.9.5 Automatic fiducial creation
Opens a dialog for automatic fiducial creation.

Summary

The dialog Automatic fiducial creation allows you to change the settings for the
automatic fiducial creation.

creation

Position style
Distance
Source layer

Delete fiducials

Fiducials auto set

Switch on the required fiducial buttons for autoematic

2
4
Highest accuracy v
4 rmm
BoardOutline v
Mothing hd

Fig. 116: Dialog Automatic fiducial creation

The following settings are available:

Name

Description

1,2,3,4

Selects the fiducials that are to be created automatically.

Position style

Selects the criterion according to which the fiducials are to be placed.
Highest accuracy: The fiducials are placed in a way that they can be
captured with high accuracy in the camera image.

Material efficient: The fiducials are placed so that the material is
optimally used.

Distance

Indicates the (outer) distance between source layer and fiducials in x
andy.

Source layer

Indicates the layer where fiducials are to be created.

Delete fiducials

Selects how to handle existing fiducials.

None: The existing fiducials remain.

All: All existing fiducials are deleted.

Overlapping: Remaining fiducials that are automatically overlapping
due to automatic creation are deleted.

Table 46: Dialog Automatic fiducial creation
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2.9.6 Power measurement
Opens the dialog Power measurement.

Summary

The laser power of the system can be measured here.

Power measurement - 0

Laser emission settings
Frequency [kHz] 50

Control value [%] 100

Internal power sensor settings

Position [mm] 10 705 =
Calib, offset 0
Calib. factor 1

Internal senscr power measurement

Power [W] 0.00

Close

Fig. 117: Dialog Power measurement

Name Description

Laser emission settings

Frequency [kHZz] Defines the frequency for operating the laser.

Control value [%] Defines the control value for operating the
laser.

Internal power sensor settings

Position [mm] Displays the position of the laser power
sensor.

Calib. offset Displays the calibration offset of the laser

power measurement.

Calib. factor Displays the calibration factor of the laser
power measurement.

Internal sensor power measurement

Power [W] Click on [Measure] to display the laser power
measured by the laser power sensor.

Powermap measurement Starts the power measurement for creating a
powermap.

Table 47: Dialog Power measurement
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2.10 Camera

In the view Camera, the camera image is displayed. The camera image can be moved

by manually entered values or via double-click.

LPKF CircuitPro PL 2019.1 - advanced edition - Untitled[S4_SingleSided_Top]

Processing  Senvice

| ©

File Edit Insert Layout Toolpaths

O HIR&|

Workdlow setup L3

I Material composition
b Layout
b Scan fields
I Tools
b Workflow
b Toolpaths
4 Processing
4 LTopSice
[ 1 Mount Material
1 [0 2 Werk package 1
[]3. Material Placement
[ 4. Drill Fielucials.
IO 5. Dvill Through-Holes
6. Structure Top
b 5] 7. Cutting Group.

L&

Camera

]

Navigation

x| 153,000 mm
y | 289,000 mm '42';‘
2| 6478 mm

| Messages

amera ? || @0 kros 1 0Wamings | @45 Messages

Referenced objects Time (descending) Status

Message

09:41:3765
09:41:3757
09:41:20.10
08:40:54 37
09:40:37 64

Data\UseCase_
Data\UseCase

@ Importzuweisung gefunden far ,C:

@ Importzuweisung gefunden fir ,C;
) Neues Dokument [Einseitig Top, ProtoLaser S4] wurde erzeugt.
) Neues Dokument [Einseitig Top, ProtoLaser 54] wurde erzeugt.
@ Fehleruberwachungskomponente gestartet

Fault monitor | Messages

Fig. 118: View Camera

The icons/functions of the toolbar are described in the following table:

Icon Name Description

" =3s Measure point to Measurement of the distance between two points.

Il point

| == Measure point to Measurement of the distance between a line and a

Innl line P point. First, the line is defined by two points and then
the point is positioned.

e Measure circle by 3 | Measure circle The circle is computed by selecting

Innl points three points on the circle.

A The fiducials are searched in the current camera image.

.‘. Fiducial search

i Extraction system SW|tch-on/off the extraction system. Switching on the

</ turn on/off extraction system produces a vacuum that fastens the
material.

* Activate pilot laser Activates/Deactivates the pilot laser

Table 48: Toolbar view Camera

Using the functions on the right side of the view Camera the processing point can be

manually moved in the directions x, y, and z.

98/184
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The following button moves the processing point in x and y direction. The processing
point is moved in the entered step size which can be changed arbitrarily.

/AT Stepsize
(4 . »| | 0,500 mm

Fig. 119: Moving in x and y direction

The following button moves the processing point in x and y direction. The processing
point is moved in the entered step size which can be changed arbitrarily.

The button [AF] activates the autofocus that tries to focus on the image automatically.

.I,f‘*'j_ ., Step size
0.500 mm

' !

."“a v /

._.:—"'l.

Fig. 120: Movement in z direction

The button % moves the image center to the position entered in the fields x, y, and z.

¥ | 160,000 mm
y | 289000 mm |

z 6,478 mm

Fig. 121: Positioning the image center to x, y, and z value
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Tab image settings

In the tab Image settings, you can adjust the parameters for the current camera
image. The changes are immediately displayed in the camera image.

Mavigation | Image settings |—
Red light I?S,EI %
E!Iack light 0,0%
1uihitva light 0,0%
Eiightness 10%
Eipnsure 10%
Glain{master] 10%

Fig. 122: View Camera | Tab Image settings
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3 Menus
The entries of the menu bar are described in the following table:
Name Description
Menu File Contains the standard functions of the application.
Menu Edit Contains functions to edit objects and their properties.
Contains functions to create objects in the user guidance
Menu Insert
step Layout.
Contains functions to edit geometric objects in the user
Menu Layout .
guidance step Layout.
Menu Toolpaths Contains various settings for toolpaths.
. Contains functions to process the previously defined
Menu Processing )
processing data.
Menu Service Contains various password-protected menu items that are
only available for the LPKF Service.
Table 49: Menus
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3.1

Menu File

This menu contains the standard functions of the application.

File |

O

pd b

=

Mew... Strg+M
Open... Strg+ 0
Recent files

Save Strg+5
Save As...

Save as template
Export... Strg+E

Print... Strg+P

Print Preview... Strg+F2

Info
Help... F1

Options...

Exit

Fig. 123: Menu File
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The entries of the menu File are described in the following table:

Icon Name Description
Starts a new project from a selected template or opens a
D New... project that is already existing (file extension *.cbf or
*.cp2d).
Opens an existing project file (file extensions *.cbf and
Open... N
.cp2d).
Recent files Displays the files that have been opened/edited recently.
E Saves the currently edited project file containing all
Save . )
changes with the same name and storage location.
Save as... Saves the currently edited project file containing all

changes with a different name and/or storage location.

Save as template

Saves the currently edited document with all changes as
template so it can be used when creating a new
document.

Export

Exports the current project.

Print...

Prints the current layout. Use the diverse settings to
optimize your print result.

Print preview...

Displays the preview of the print results using the current
print settings.

Info Contains information on software and hardware.
Help... Displays the detailed help.
Options... Contains application settings, such as language settings.
3 Exit Exits and closes the current application.
Table 50: Menu File
3.1.1 New

Starts a new project from a selected template or opens a project that is already
existing (file extension *.cp2d or *.cbf).

Summary

The command New enables you to create a new project file based on an existing,
installed template or to search on your computer for a custom template that is suitable.
The tab Projects lists the recently edited projects.

3.1.2 Open
Opens an existing project file (file extensions *.cp2d and *.cbf).

Summary

In the dialog to be displayed, navigate to the desired file and click on Open. The data
are displayed in the user guidance step Layout.

3.1.3 Recent files
Displays the files that have been recently opened/edited.

V. 1.1 | LPKF Laser & Electronics AG
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3.1.4 Save

Saves the currently edited project file containing all changes with the same name and
storage location.

3.1.5 Saveas

Saves the currently edited project file containing all changes with a different name
and/or storage location.

3.1.6 Save as template
Saves the actual edited project file with all changes as a template.

3.1.7 Export
Exports data to an *.LMD file.

Summary

The LMD file is used for data transfer between LPKF software products.

B Exporting a project

1. Click on File > Export...
2. The following dialog is displayed:

Export -
Mapping Preview
Phase file
CircuitPro phase(s)/work package(s) | Map to phase ‘ Map to tool name(s)
4 [w]Bottom Side _B0.10
[#|BottomLayer_Hatching Structure_Bottom [ v ] Hatch
BottomLayer_InsuIatE Structure_Bottom Contour, Contourll
[¥BottomLayer_Dividing Structure_Bottom DivideStrip
[¥|BottomLayer_Cutting Structure_Bottom Contour
EottomLayer_ShortHeatmg Rubout_Bottom EI ShortHeat
[¥]BottomLayer_Heating Rubout_Bottom [%] Heat
F\duc\alf\ducials Structure_Top EI Fiducial
[#|Read_Fiducials Read_AllLayers  [¥] QuickLoadCircuit
[ DrillPlated_Drill Plated [¥]
4 ¥ Top Side
TopLayer_InsuIatE Structure_Top Contour, Contourll
[ TopLayer_Hatching Structure_Top Hatch
[¥|TooLaver Dividina Structure Too  [w] DivideStrin
< >
Export to ile | LMD I[-]
Expart | | Clase | | Cancel |

Fig. 124: Dialog Export

O The phase file is attached automatically. The columns CircuitPro phase(s)/work
package(s), Map to phase, and Map to tool name(s) are filled with the required
information from the phase file.

If the phase file is not attached automatically you can find it in the installation folder of
CircuitMaster or BoardMaster.

3. Inthe field Export to file, enter a name for the LMD file and select a location for
saving.
4. Click on [Export].

V] The project has been exported.
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3.1.8 Print
Prints the current layout. Use the diverse settings to optimize your print result.

Summary

Click on [Print], to start the print process with the current settings.
To change the print options, various tabs are available.

Tab General

Contains general settings for the print process (number of pages, page range, etc.).

Print [ x |

General | PageSetup | Settings | Printer Calibration

2% RightFax Fax Printer

G

Fig. 125: Tab General
Select Printer

Select in this group the printer that is to be used for executing the print job. Use the
button [Properties], to change the settings for the printer.

Page Range

In this group, select the pages to be printed. As soon as you want to print more than
one copy, the option Collate is activated. This setting ensures that a complete copy
is printed, before the next copy is started to be printed.

View
Here, you can define which view is to be printed.
Print area

Define in this group if the current view, the entire layout, the marked areas, or all is
to be printed.
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Tab Page Setup

Contains general settings for the page to be printed (paper size, orientation).

Print

General | PageSetup | Settings | Printer Calibration

0
r_}'
]
<]

Orientation Margins

Preview Print Cancel Apply

Fig. 126: Tab Page Setup
Paper
Select the paper size and the paper tray of the printer.
Orientation
Select the orientation of the paper (portrait, landscape).
Margins

Defines the size of the margins.
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Tab Settings

Contains settings for the layout of the image to be printed (scaling, mirroring etc.).

Print

General Page setup Printer calibration
[] Enable colors [ Inverse
[] Auto rotate ] Mirror v
[] Include file name in print output
Scaling Page count

@) Best fit according paper size (@) One page (center, cropped)

011 () Page count accerding te scaling

) Manual scaling QOverlap

Preview Cancel Apply

Fig. 127: Tab Settings
This group offers the following options:
— Enable colors
Activates color printing

— Auto rotate
Adjusts the page orientation according to the orientation set in the printer
properties.

— Include file name in print output
Prints the file name of the project on every sheet.

— Inverse
Causes a display inversion of the rubout area, i.e. the area that is removed
during production (e.g. rubout area) is not printed.

— Mirrory
Mirrors the object to be printed along the y axis.
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Scaling
This group offers the following options:
— Best fit according paper size
Automatically adjusts the printout to the preselected paper size.
- 1:1
Causes that the printout is printed in the actual size. There is no
scaling/adjusting to the actual paper size. Large graphics can be spread across

several sheets. Small graphics can be too small and may thus be unreadable in
some circumstances.

— Manual scaling
Scales the printout according to the entered value.

Page count
In this group, you can define which view is to be printed.

— One page (center, cropped)
Prints the graphic centered on one page, i.e. that possibly enlarged graphics
that would be printed on several sheets are trimmed.

— Page count according to scaling
Prints the pages exactly in accordance with the specified number of pages in
the print preview.
Tab Printer Calibration

Contains parameters (rectangle size, printed size etc.) for calibrating the printer.

Print En

General | PageSetup | Settings | Printer Calibration

Rectangle size Printed size Correction factor
160 mm 160 mm 1

250 mm 250 mm 1

Print calibration rectangle

Preview Print Cancel Apply

Fig. 128: Tab Printer calibration
Parameters
This group provides the following options:
— Rectangle size:
Defines the size of the calibration rectangle by entering values for x and y.

—  Printed size:
Used for the entry of the actual printed rectangle size.

—  Correction factor:
Automatically displays the difference between the Rectangle size and the
entered size in the Printed size.
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3.1.9 Print preview
Displays a preview of the printed layout.

Summary

The print preview enables you to check the layout to be printed on the screen and to
change the display via various settings.

Print preview - 0 “

@ | Settings | Q- View » Mode v Printarear | ] Lof 1 p [p XClose

Fig. 129: Dialog Print preview
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The dialog Print preview contains the following icons/functions:

Icon/Button Description

ﬁ Starts the printing operation.

Settings Opens the dialog Print | Settings.

Q Zooms in/out the view of the page to be printed.

View Offers the option to select between the view for 2D objects and the
view for 3D objects.

Mode

One page Displays one page of the document to be printed.

Two pages Displays two pages of the document to be printed.

Three pages

Displays three pages of the document to be printed.

Four pages Displays four pages of the document to be printed.
Six pages Displays six pages of the document to be printed.
Print area

All visible Limits the print area to all visible objects.

View Limits the print area to the current view.

Full layout Adapts the print area to the full layout.

Selection Limits the print area to the current selection.

d

Displays the first page.

<

Displays the previous page.

Page number

Displays the current page number.

-

Displays the next page.

>

Displays the last page.

x Close

Closes the dialog Print preview.

Table 51: Dialog Print preview

3.1.10 Info

Contains information on software and hardware.

Summary

Software...

Displays the version numbers and copyright of the program component.

Hardware...

Displays information about the PC running the application.

Operating hours...

Displays the Operating hours of the system, the activated hours in CircuitPro, as well
as Operating hours of the laser.
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3.1.11 Help...

The menu item Help provides information on operating the software.

3.1.12 Options

Contains application settings, such as language settings.

Context sensitive help texts that are relevant for the selected option are displayed in

the lower area of the dialog:

4 [ Import / Export
[ Import assignments
4 [3 Formats
[ Gerber
[ Excellon
0 LMD
[ HPGL
[ DxF
[ cr2p
[ Miscellaneous
[} Machine
4 [J Logging
[0 Logging
[ General

Options - 0O
4 [ All settings 4 1. Application
[ General 1.1. User level Operator
4 [ Display 1.2. Language English (United States)
[ Grid 1.3 Units Millimeters
[ snap 1.4. Decimal separator

4 2. Undo/Redo

2.1, Undo/Redo level 50
4 3. User and license information

3.1. User name MM

3.2. Organization

3.3. Location MM

34, License key
4 4 Auto save

4.1. Time interval (min) 10
4.2, Auto save mode True
1.1. User level

Sets the availability of views and operations in the application accerding to the selected
user level

0K | | Cancel
Fig. 130: Help texts in the dialog Options
3.1.13 Exit
Exits and closes the current application.
111/184
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3.2 Menu Edit

This menu contains functions to edit objects and their properties.

Edit

€ Undo Strg+Z

Fig. 131: Menu Edit

The icons/functions of the menu Edit are described in the following table:

Icon Name Description
(-,) Undo Undoes the last action performed.
Redo Executes the last action once more that was undone by
'C) clicking on [Undo].
o R Executes the last action once more.
epeat
Cut Removes the selected item(s) and puts them into the
% clipboard.
by Copies the selected item(s) and puts them into the
Copy clipboard.
.3 Pastes the contents from the clipboard to the cursor
Paste "
O position.
x D Deletes the selected items.
elete

Table 52: Menu Edit

3.21 Undo
The last action is undone.

Summary

Click on/Tap on [Undo] to undo the last action and to restore the previous state.
The number of actions that can be undone can be set in the options.

[Undo] can also be executed with the key combination +(2].

3.2.2 Repeat
Executes the last action once more.

Summary
Click on/Tap on [Repeat] to execute the previously performed action again.
[Repeat] can also be executed with the key combination + [v].
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3.2.3 Redo
Executes the last action once more that was performed by clicking on [Undo].

Summary

Click on/Tap on [Redo] to execute the previously performed action again that was
performed by clicking on [Undo].

[Redo] can also be executed with the key combination +[(v].

3.24 Cut
The selection is removed and added to the clipboard.

Summary

Click on/Tap on [Cut] to remove the marked contents and to add them to the
clipboard. These contents can be reinserted via [Paste].

[Cut] can also be executed with the key combination + [ x]J.

3.25 Copy
The selection is copied to the clipboard.

Summary

Click on/Tap on [Copy] to copy the marked contents to the clipboard. Use [Paste] to
insert these contents to the cursor position.

[Copy] can also be executed with the key combination + (.

3.2.6 Paste
Pastes the contents from the clipboard to the cursor position.

Summary

Click on/Tap on [Paste] to add contents from the clipboard to the cursor position. For
example, these can be added to the clipboard via [Cut] or [Copy].

[Paste] can also be executed with the key combination + [v].

3.2.7 Delete
The marked contents are removed.

Summary

Click on/Tap on [Delete] to remove the marked texts or objects (e.g. layers, toolpaths,
etc.).

Accidently removed contents can be restored with [Undo].
[Delete] can also be executed with [Del ].
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3.3 Menu Insert

This menu contains functions to create and edit objects in the user guidance step

Layout.
Insert
¥ Flash
/' Path
& rolygon
B FRectangle or rectangle path... k
W  Circle orcircle path... L
T Tet
EE  Data Matrix code
w Fiducial
1'{_1 Automatic fiducial creation
4 Create fiducial with defaults
mi Create instance type...

Fig. 132: Menu Insert

The icons/functions of the menu Insert are described in the following table:

Icon Name Description
Flash Creates a flash based on the aperture currently selected.
Path Creates a path in the current layer.
Polygon Creates a polygon in the current layer.
Creates a filled rectangle in the current layer.
Rectangle

Rectangle path

Creates a rectangle path in the current layer.

Circle by diameter

Creates a filled circle by defining a diameter.

Circle by points

Creates a filled circle by setting three points.

O ® G| B e\ |~

Circle path by diameter

Creates a circle path by defining a diameter.

)

Circle path by points

.
e

Creates a circle path by setting three points.

o]

Create text object

Creates a text field.

B
o

Create Data Matrix code

[oh

Creates a Data Matrix code

LPKF Laser & Electronics AG | V. 1.1
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Icon Name Description
. Creates a new fiducial.
‘-' Fiducial
Y Automatic fiducial Opens a dialog automatic fiducial creation.
q A creation
+ Create fiducial with Creates a fiducial with the default camera settings.
=z | defaults
L3 | create instance tvoe Creates an instance type from the selected objects where
HH YPE- lthe objects are used as the primary instance.

Table 53: Menu Insert

3.3.1 Flash
Creates a flash based on the aperture currently selected.

Summary

Use the function [Flash] to create a flash on the basis of the apertures in the aperture
library. If no aperture is selected the first aperture in the library is used.

The flash is assigned to the currently selected layer.

3.3.2 Path
Creates a path in the current layer.

Summary

Apply the [Path] function to create open and closed paths in the user guidance step
Layout. These paths are automatically assigned to the currently selected layer and
use the selected aperture or path. Only circular apertures can be used for paths.

To close a path, you must create the last point, then select [Close open path] in the
context menu. The paths are automatically connected to close the shape.

Fig. 133: Creating a path
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3.3.3 Polygon
Creates a polygon in the current layer.

Summary

Use the function [Polygon] to create polygons in the user guidance step Layout. These
polygons are automatically assigned to the currently selected layer. The individual
lines can be created as straight lines or as arcs. Once the element is finished, it is
filled automatically.

Open the context menu and click on [Finish] or press to close the polygon.

Fig. 134: Create polygon

3.3.4 Rectangle
Creates a filled rectangle in the current layer.

Summary

Use the function [Rectangle] to create filled rectangles in the user guidance step
Layout. The objects are automatically assigned to the currently selected layer.

Fig. 135: Creating a rectangle
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3.3.5 Rectangle path
Creates a rectangle path in the current layer.

Summary

Use the function [Rectangle path] to create rectangle paths in the user guidance step
Layout. The objects are automatically assigned to the currently selected layer.

Fig. 136: Creating a rectangle path

3.3.6 Circle by diameter
Creates a filled circle of a defined diameter.

Summary

With [Circle by diameter] you can create circles in the user guidance step Layout. After
creation, the circles are automatically filled and assigned to the currently selected
layer.

Fig. 137: Creating circle by diameter
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3.3.7 Circle by points
Creates a filled circle by setting three points.

Summary

Use the function [Circle by points] to create circles in the user guidance step Layout.
After the circles have been created, they are automatically filled and assigned to the
currently selected layer.

Fig. 138: Creating a circle by points

3.3.8 Circle path by diameter
Creates a circle path by the defined diameter.

Summary

With [Circle path by diameter] you can create circle lines in the user guidance step
Layout. Once created, the circle paths are automatically assigned to the active layer.

Fig. 139: Creating circle path by diameter
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3.3.9 Circle path by points
Creates a circle path by setting three points.
Summary

Use the function [Circle path by points] to create circle paths in the user guidance step
Layout. After the circle paths have been created, they are automatically assigned to
the active layer.

Fig. 140: Create circle path by points
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3.3.10 Create text object
Creates a text object in the current layer.

Summary

Use the function [Create text object] to create text objects in the user guidance step
Layout. In addition to conventional texts and numbers, the text objects can also
contain the serial number, the current date, and variables.

The texts are automatically assigned to the currently selected layer.

Fig. 141: Create text

'.h . ToplLayer (2309) | v Segoe Ul v 3Imm B I T :: ; ::
Fig. 142: Toolbar Create text object
Icon Name Description
Displays the currently selected layer. You can
W o] | Selected layer change this by opening a drop-down list with a left-
click and selecting a different layer from the list.
Displays the currently selected font. You can
- | Font change this by opening a drop-down list with a left-
click and selecting a different font from the list.
Font size Displays the currently selected font size. Enter the
3 mm desired value for the font size into the input field.
B Bold Displays the currently selected text in bold letters.
0
I ltalic Displays the currently selected text in italics.
Displays the currently selected text as an outline.
T Outline Pay 4
— Aligns text objects to the left of the input field.
— _  |Left
- Aligns text objects to the center of the input field.
Rl Center
- Aligns text objects to the right of the input field.
_— Right
Table 54: Functions Create text object
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With the functions in the right toolbar you can insert variable contents into the text

object. Their values are not static but are adjusted at a certain point in time. Click on
to add a variable. Variables of the format Number can be additionally assigned a

type (Serial number, Batch, or Lot). Click on ™! to add the variable into the text field.

Dynamic ohjects

Numbers
Type SerialNumber
Description Serial number
Length 9
Initial walue 1

Reset each batch []

Text
Description | Text 1

Length 20

Date
Example 2020/06/29

Date yyyy/MM/dd

n

L

Fig. 143: Settings for text objects with dynamic contents

Name Description
Number
Defines the type of the variable. You can select between
the following types:
e  Serial number
At the start of each production, the serial number is
incremented by one value. If there are several serial
numbers and the length is changed, this value
changes for all serial numbers.
Type e Batch
The value is incremented by 1 when the maximum
number of serial numbers (length) has been
reached.
e Lot
Indicates the number of fully produced batches. The
value is incremented by 1 when the maximum
number of batches has been reached.
Description Indicates the description of the variable.
Defines the maximum number of digits for this variable.
Length Example:

At a length of 3, the maximum value is 999.

V. 1.1 | LPKF Laser & Electronics AG

121/184



Menus

CircuitPro PL 3.5

Name

Description

Initial value

Defines the initial (starting) value of the variable.

Reset each batch

Activates/Deactivates resetting the serial number after
each batch.

Batch size

Defines the maximum batch size. A batch has been
produced, when the maximum serial number has been
reached.

Reset each lot

Activates/Deactivates resetting the count after each lot.

Defines the maximum lot size. A lot has been produced,

Lot size when the maximum batch size has been reached.

Text

Description Specifies the description of the variable.

Length Indicates the maximum character length of the variable.
Date

Example sDjé)(ljgg ?o?rﬁgimple of the date according to the

Date Defines the format used for displaying the date.

Table 55: Functions for dynamic text objects

When adding dynamic objects, the user guidance step Layout only displays example

values.

3.3.11 Create Data Matrix code

Creates a Data Matrix code in the current layer

Summary

Use the function [Create Data Matrix code] to create a 2D code in a rectangular matrix
in the user guidance step Layout. This code can be read using a camera.
The Data Matrix codes are automatically assigned to the currently selected layer.

Specify DMC position

B

Fig. 144: Create Data Matrix code
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With the functions in the right toolbar, variable contents can be displayed as Data
Matrix code. These values are not static but are adjusted at a certain point in time.
Click on == to add a variable of a specific data format (Number, Text, or Date).
Variables of the format Number can be additionally assigned a type (Serial number,
Batch, or Lot). Click on ™ to insert the variable into the text field.

Text

Date

Dynamic chjects

MNumbers
Type SerialNumber
Description Serial number
Length 9
Initial value 1

Reset each batch []

Description | Text 1

Length

Example 2020/06/29

Date yyyy/ MM/ dd

i1

W

Fig. 145: Settings for Data Matrix code with dynamic contents

Name

Description

Number

Type

Defines the type of the variable. You can select one of
the following types:

Serial number

At the start of each production, the serial number is
incremented by one value. If there are several serial
numbers and the length is changed, this value
changes for all serial numbers.

Batch

The value is incremented by 1 when the maximum
number of serial numbers (length) has been
reached.

Lot

Indicates the number of fully produced batches. The
value is incremented by 1 when the maximum

V. 1.1 | LPKF Laser & El
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Name Description
number of batches has been reached.
Description Defines the description of the variable.
Defines the maximum number of digits for this variable.
Length Example:
At a length of 3 the maximum value is 999.
Initial value Defines the initial (starting) value of the variable.

Reset each batch

Activates/Deactivates resetting the count after each
batch.

Batch size

Defines the maximum batch size. A batch has been
produced, when the maximum serial number has been
reached.

Reset each lot

Activates/Deactivates resetting the count after each
batch.

Defines the maximum lot size. A lot has been produced,

Lot size when the maximum batch size has been reached.
Text

Description Defines the description of the variable.

Length Defines the maximum character length of the variable.
Date

Example Ejgclgj ]?c)r;rﬁ:?mple of the date according to the
Date Defines the format used for displaying the date.

Table 56: Functions for dynamic Data Matrix codes

3.3.12 Fiducial

Displays a fiducial at the cursor position. Left-click to determine the center of the

fiducial and to create the fiducial.

Summary

The total size of the fiducial can be defined by the diameter in Options >
Miscellaneous> Fiducial > Diameter.
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3.3.13 Automatic fiducial creation
Opens a dialog for automatic fiducial creation.

Summary

The dialog Automatic fiducial creation allows you to change the settings for the
automatic fiducial creation.

creation

Fiducials auto set

Switch on the required fiducial buttons for autoematic

2
3 4
Position style Highest accuracy v
Distance 4 rmm
Source layer BoardCutline hd
Delete fiducials | Mothing hd

Fig. 146: Dialog Automatic fiducial creation

The following settings are available:

Name

Description

1,2,3,4

Selects the fiducials that are to be created automatically.

Position style

Selects the criterion according to which the fiducials are to be placed.
Highest accuracy: The fiducials are placed in a way that they can be
captured with high accuracy in the camera image.

Material efficient: The fiducials are placed so that the material is
optimally used.

Distance

Indicates the (outer) distance between source layer and fiducials in x
andy.

Source layer

Indicates the layer where fiducials are to be created.

Delete fiducials

Selects how to handle existing fiducials.

None: The existing fiducials remain.

All: All existing fiducials are deleted.

Overlapping: Remaining fiducials that are automatically overlapping
due to automatic creation are deleted.

Table 57: Dialog Automatic fiducial creation
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3.3.14 Create fiducial with defaults
Creates a fiducial with standard camera settings.

Summary

To change standard values, open the user guidance step Camera and click [Library].
Select the entry marked as Standard and adopt the current camera settings by using
[Apply] or [OK].

3.3.15 Create instance type...
Creates an instance type with the selected objects as a primary instance.

Summary

An instance type consists of a primary instance and at least one instance. Instances
are references to the primary instance. The primary instance is produced at the
position of the individual instance during processing.

Subsequent changes to the primary instance are applied only partially. Once you
remove an object, this is applied immediately to the instance. If you want to add new
objects, you have to dissolve the instance type and create it anew with the added
objects

The fiducials contained in the primary instance are created as local fiducials and are
also multiplied during processing.

Fig. 147: Instance type (with primary instance and three instances)

To create tool paths for an instance type, you must use the user guidance step
Workflow to assign it to an instance group.

Compared to multiplied data (Step and Repeat), instances have several advantages:

e You need less memory. As a result, the data is loaded faster and its calculation
accelerated.

e Tool paths are only calculated for the primary instance and reused for the other
instances. This greatly speeds up the calculation of the tool paths.
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3.4

Menu Layout

This menu contains functions to create and edit geometric objects in the user

guidance step Layoult.
Layout
L.;. Mawve object  Strg+M
Rotate
Mirror

sy BE @

Scale/Expand
Difference/Merge
Split

Round/Chamfer
Set zero point

Fill/Contour
Path manipulation

Modify flash
Group
Measure

Design rule check..,

Aperture list library...

Fig. 148

. Menu Layout

The icons/functions of the menu Layout are described in the following table:

Icon

Name

Description

Move object

Moves the selected object by a defined distance and
direction.

Q|

Rotate

Rotates one or multiple objects around a definable pivot
point.

Mirror horizontally

Mirrors one or multiple objects around the horizontal
coordinate axis (x axis).

Mirror vertically

Mirrors one or multiple objects around the vertical axis of
reflection (y axis).

Scales up or scales down the marked object by the scale

o7 |63 BT | ™ | 4

Scale factor.

Expands or shrinks the marked object by a definable
Expand

length.
Merge Merges adjoining or overlapping objects to a single

geometrical object.
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Icon Name Description
. Removes the area of a geometrical object that is
Difference ;
overlapped by a second selected object.
69 Split Splits a marked object using a predefined path.
- IR Rounds the corners of the marked object.
I ound
- Chamfers the corners of the marked object.
Chamfer

Set zero point

Sets the zero point to the selected position in the user
guidance step Layout.

Convert to polygon

Converts a selected closed path into a filled object.

Convert to closed path

Converts a filled object into a closed path.

Add point

Adds a point on a selected line.

Add mirror point

Adds two points with the same distance from the
reference point.

R AR N ™

Move point

Moves a selected point.

Fu | P

]

Split path

Splits the selected line segment of a path

Reduce number of
elements

Removes redundant points in the selected object.

Change line width

Changes the line width of the selected path.

Change arc radius

Changes the arc radius of the selected path.

Close open path

Connects both end points of an open path with a line.

Convert to flash

Converts a selected object into a flash object.

Combine to flash

Combines two or more selected objects to one flash
object.

Compare to flash

Compares the selected flash with objects on the same
layer. Objects of the same shape are converted into a
flash.

Explode flash Converts the flash into an object.

@ Group Groups selected objects.

IEI Ungroup Ungroups grouped objects.

=3 Measures the distance between two points.

easure

Tl
Design rule check Opens the dialog Design rule check.
Aperture list library Opens the dialog Aperture list library.

Table 58: Menu Layout

128/184
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3.41 Move object
Moves the marked object by a defined distance and direction.

Summary

Before moving, a reference point has to be specified. This point can also be located
outside of the marked object/marked contour or even be created on other
objects/contours. After the reference point is specified, the distance and direction can
be defined.

Fig. 149: Moving an object/a contour

3.4.2 Rotate
Rotates one or multiple objects around a definable pivot point.

Summary

The marked objects/contours are rotated around one point. Thereby, you choose the
position of the angle point and the rotation angle.

Fig. 150: Rotating an object/a contour
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3.4.3 Mirror horizontal
Mirrors one or multiple objects around the horizontal axis of reflection (x axis).
Summary

The axis of reflection is located at the centroid of area of the selected object. If
multiple objects are selected, a common centroid of area is calculated that is used for
the reflection. The centroid of area can even be located outside of the objects.

Fig. 151: Mirror object horizontal

3.4.4 Mirror vertical
Mirrors one or multiple objects around the vertical axis of reflection (y axis).

Summary

The axis of reflection is located at the centroid of area of the selected object. If
multiple objects are selected, a common centroid of area is calculated that is used for
the reflection. The centroid of area can even be located outside of the objects.

Fig. 152: Mirror object vertical

3.45 Scale
Scales up or scales down the marked object by the scale factor.

Summary

All lines of the object are scaled uniformly so they keep their shape even after
increasing/reducing the size.

Specify scaling coefficient
Scale coefficient = 96

Fig. 163: Scaling an object
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3.4.6 Expand
Increases or decreases the marked object by a definable offset to the contour.

Summary

The marked object is increased or decreased uniformly around all sides. Increasing
the object can cause a significant change of the shape.

Fig. 154: Expanding an object

The function is only available if a single object is marked. Multiple objects cannot be
expanded at the same time.

3.4.7 Difference

Removes the area of a geometrical object that is overlapped by a second selected
object.

Summary

[Difference] is only available if a filled object is selected. If the function is activated, a
second object has to be selected. The area where the objects are overlapping is
deleted.

After using this function, the second object is deleted by default. This setting can be
changed in the options.

Objects that have been edited with [Difference] can only be restored to the previous
state with [Undo].

= Ly

Fig. 155: Difference
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3.4.8 Merge
Merges adjoining or overlapping objects to a single geometrical object.

Summary
[Merge] is only available if at least two geometrical objects are marked.

Merged objects can only be restored to the previous state with [Undo].

+

Fig. 156: Merge objects

The created object is assigned to the layer of the objects used. If the objects are
located on different layers, the newly created object is assigned to the upmost layer
used.

3.49 Split
Splits a marked object by using a predefined path.
Summary

When splitting, the line located on the object to be split is drawn first. Later, this line
shall be used as a dividing line. Then select the object and enable the [Split] function.
Click the line to split the object at the position of the line.

Fig. 157: Splitting an object
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3.4.10 Round
Rounds the corners of the marked object.

Summary
You can determine the radius of the rounding and select the corners to be rounded.

There is a differentiation between the outer and the inner corners.

Fig. 158: Rounding corners

Outer angles have an angle that is smaller than 180° within the geometrical object.

Fig. 159: Outer angles

Inner angles have an angle that is greater than 180° within the geometrical object.

Fig. 160: Inner angles
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3.4.11 Chamfer
Chamfers the corners of the marked object.

Summary

You can determine the length of the sides to be chamfered and the angles to be
chamfered.

There is a differentiation between the outer and the inner angles.

Fig. 161: Chamfer angles

Outer angles have an angle that is smaller than 180° within the geometrical object.

Fig. 162: Outer angles

Inner angles have an angle that is greater than 180° within the geometrical object.

Fig. 163: Inner angles

3.4.12 Set zero point
Sets the zero point to the selected position in the user guidance step Layout.

Fig. 164: Setting zero point

3.4.13 Convert to polygon
Fills a marked closed path.
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Summary

[Convert to polygon] is only available if a closed path is marked.

Fig. 165: Converting object to polygon

3.4.14 Convert to closed path
Removes the filling of filled objects.

Summary

[Convert to closed path] is only available for marked and filled objects.

Fig. 166: Converting object to closed path
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3.4.15 Add point
Adds a point on a marked line segment.

Summary

[Add point] is only available if a line or a point of a segment is marked.

Fig. 167: Add point

3.4.16 Add mirror point
Adds two points with the same distance from the reference point.

Summary

[Add mirror point] is only available if a line or a point of a segment is marked.

Fig. 168: Add mirror point
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3.4.17 Move point
Moves a marked point.

Summary

The marked point can be moved by using the mouse or by entering the relative
coordinates. Multiple points can be marked as long as they are within the same object.

Fig. 169: Move point

3.4.18 Spilit path
Splits the marked line segment of a path.

Summary

The line segment can be split at the mouse position or by entering relative coordinates
referring to the center of the path or the selected point.

Fig. 170: Split path

[Split path] cannot be used for filled objects.
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3.4.19 Reduce number of elements
Removes redundant points in the marked object.

Summary

The shape of the object is not changed. Only the points that are not required for the
current shape are removed.

Fig. 171: Reduce number of elements

3.4.20 Change line width
Changes the line width of the marked path.

Summary

[Change line width] is only available if a path is marked. When increasing the line
width, the outer corners are rounded.

The line width is entered as a fixed value in mm.

Fig. 172: Change line width
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3.4.21 Change arc radius
Changes the arc radius of the selected path.

Summary

[Change arc radius] is only available if a path is marked. This function can also be
selected via the context menu. The arc radius is changed by defining a distance from
the original path.

Fig. 173: Change arc radius

3.4.22 Close open path
Connects both end points of an open path with a line.

Summary

[Close open path] is only available if an open path is marked. The marked object is
converted to a closed path.

Fig. 174: Close open path
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3.4.23 Convert to flash

Converts a marked object into a flash.

Apertures | — Line M F /@ 0D T

Drill Plated Drills

Construct line [0 mm)

Flash

Layer:  Drill Plated Drills

Aperture: ¥ 010

Fig. 175: Converting an object into a flash

3.4.24 Combine to flash

Combines two or more marked objects to one flash.

Summary

Geometrical objects as well as flashes can be used. After combining the objects, an

aperture based on the newly created flash is created.

The combined objects within the flash can only be moved together.

Apertures | D10 ] F [ )

_~_

Polygon
Layer: Drill Plated Drills

Aperture: Construct line [0 mm]

Layer:  Drill Plated Drills
Aperture: J€ D11

Fig. 176: Combining objects to flash

3.4.25 Compare to flash

Compares the marked flash with objects on the same layer. Objects of the same

shape are converted into a flash.

Summary

Smaller deviations of the object's size and angles can be adapted by entering

tolerance values in the dialog.

3.4.26 Explode flash
Converts the flash into an object.
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3.4.27 Group
Groups marked objects.

Summary

[Group] is only available if at least two objects are marked.

Fig. 177: Group objects

3.4.28 Ungroup
Ungroups objects.

Summary

[Ungroup] is only available if grouped objects are marked exclusively.

3.4.29 Measure
Measures the distance, starting from the selected position.

Summary

The selected position is used as the initial point for measurement. As soon as you
select another position, it is used as initial point for measurement.

4,387 mm

Fig. 178: Measure from point to point
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3.4.30 Design rule check
Opens the dialog Design rule check.

Summary

Use the Design rule check for checking if the PCB layout complies with the defined
and recommended standards of the Design rule check.

Design Rule Check - [ x |
Inter Min Spacing (® Intra Min Spacing
Source objects: | <Selected objects> EI
Additional source objects:
Layer Recult | <Create new layer> [¥]
Width: | 0,1 mm
Run

Fig. 179: Dialog Design rule check
The following can be checked with the Design rule check:

e Spacing of objects on different layers.
e Spacing of objects on the same layer.

3.4.31 Aperture list library...
Opens the dialog Aperture list library.

Summary

In the dialog Aperture list library, aperture lists can be copied, edited, deleted and
imported.

Aperture list library - O
ApertureListsLibrary.cbf Open.
<< current document >> BoardApe: \
D10

B X
I Remove oK

Fig. 180: Dialog Aperture list library
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3.5 Menu Toolpaths

This menu contains settings for toolpaths.

Toolpaths

i Compute all...

Fig. 181: Menu Toolpaths

The icons/functions of the menu Toolpaths are described in the following table:

Icon Name Description
Zﬂ Computes the toolpaths based on the computed scan
Compute all... .
_ fields and work packages.

Edit breakout tabs... Edits the breakout tabs of the workpiece.

Table 59: Menu Toolpaths

3.5.1 Compute all...
Computes the toolpaths based on the computed scan fields and work packages.

3.5.2 Edit breakout tabs
Opens a dialog for editing the settings of the breakout tabs.

Summary

In the dialog Edit breakout tabs position the Gap width can be modified, the Break
position can be changed by entering values for x and y , the breakout tabs can be
deleted, and the breakout tabs can be created.

The dialog is structured as follows:

Edit breakout tabs position -
Work package | Contour | v

Gap width 0,25 mm

Breakout tab position

I 40,216 mm |y 7,302 mm

Add breakout tah

Rernove breakaout tah

Apply Clase

Fig. 182: Dialog Edit breakout tabs position
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The following settings are available:

Function Description

Work package List for selecting a work package.

Gap width Indicates the width of the breakout tabs.

Break tab position Indicates the x and y position of the selected
breakout tab.

Project Indicates the projection of the breakout tab.

Add breakout tab Adds a new breakout tab.

Remove breakout tab Deletes the selected breakout tab.

Table 60: Dialog Edit breakout tabs position
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3.6 Menu Processing

This menu contains functions for processing the previously defined processing data.

Processing
gﬂ Placernent..,

Check copper thickness

Alignment settings...

Material thickness measurement setting

Process all

Laser beam diagnostics ]
Import/Export calibration settings

Connect to machine...

Fig. 183: Menu Processing

The entries of the menu Processing are described in the following table:

Icon Name Description

s Placement Opens a dialog for shifting the processing data.

L]

Check copper thickness | Opens a dialog for checking the copper thickness.

Opens a dialog for configuring the fiducial search. While
Alignment settings... processing, these settings are used for the fiducial
search.

Opens the dialog Material thickness measurement
settings This dialog is only available if the connected
machine allows a material thickness measurement.

Material thickness
measurement setting

Process all Starts the production of all processing data.

. Stop processing Stops the production of the processing data.

. Opens the dialog Power measurement.
bs | Power measurement

Laser beam diagnostics | Opens the dialog Laser diagnostics.

Import/Export calibration | Opens a dialog for importing and exporting calibration
settings settings.

Opens a dialog for connecting the system software to a

Connect to machine... . )
real or simulated machine.

Table 61: Menu Processing
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B Referencing the processing area

After replacing or cleaning the sinter plate and after transporting the system, it is
recommended to re-reference the processing area. This function is only available if
the required sensor is present in the system.

1. Inthe menu Processing, click on Material thickness measurement setting.
2. Click on [Perform referencing] to start the procedure.

O The message Thickness measurement running is displayed.

3. Wait until the measurement is finished.

3.6.1 Placement...
Opens the dialog Placement for rotating and moving the processing data.

The dialog Placement allows correct placement of the material. Once the toolpaths
and scan fields have been generated, the tab Processing data is also displayed.

Placement -
Material

Click into the processing area to move the active head to the associated
position. Use the buttons to set the left front and right rear corner of the

material.
- ]
x 0005 mm ¥ 305,53 mm
y 0130mm y 2470 mm
Width 305 mm | Length 22% mm Set default size

Use a caliper to measure the material thickness

Material thickness 0,322 mm Ieasure matenal thickness

[l Cancel

Fig. 184: Dialog Placement

The button [Measure material thickness] starts the automatic measurement of the
material thickness. This function is used for unconventional material thicknesses and
is only available if the required sensor is present in the system.
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The following functions are available in the tab Material:

Name Description
Material
Width Specifies the width of the material.
Length Specifies the length of the material.
Set default size Resets the width and length to the initial value.
Material thickness Specifies the material thickness.
Measures the thickness of the material. You can
. . find more settings for the thickness measurement
Measure material thickness . . . ;
in the menu Processing under Material thickness
measurement setting.

Table 62: Dialog Placement | Tab Material

Placement - O

| Material Processing data |

Drag and drop the bounding box of data in the processing view,

Center of processing data  x | 153 mim | ¥ | 1325 mm |
Angle | o® Izl
Use information layers | Center on material |

Processing head

| Center an data |

| Show bounding box |

Ok | | Cancel

Fig. 185: Dialog Placement | Tab Processing data
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The following functions are available in the tab Processing data:

Name Description

Specifies the center of the processing data in x

Center of processing data and y direction.

Angle Rotates the processing data by a definable angle.

Takes the information layers into account when

Use information layers placing the processing data.

Positions the processing data on the center of the

Center on material .
material.

Processing head

Positions the processing head at the center over

Center on data the machining data.

Show bounding box Shows the bounding box of the processing data.

Table 63: Dialog Placement | Tab Processing data

3.6.2 Check copper thickness
Opens a dialog for checking the copper thickness.

Summary

In the dialog Copper thickness the copper thickness required for the process can be
checked and changed if necessary.

Copper thickness - N |
Enter the copper thickness:
OK Cancel

Fig. 186: Copper thickness

You can create a work package of the type Instruction in the user guidance step
Workflow containing the instruction Check copper thickness to open this dialog
automatically during production.
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3.6.3 Alignment settings
Opens a dialog for configuring the fiducial search.

Summary

In the dialog Alignment settings you can configure the fiducial search settings. While
processing, these settings are used for the fiducial search.

You can adjust the search area, the fiducial criteria, and the alignment settings.

Alignment settings -
ROI configuration
Width (mm) | 84 mm Height (mm) | 48 mm
Offset X (mm) 0 mm Offset ¥ (mm) 0 mm
Change ROI by mouse Change ROI border calor
Fiducial criteria
Diameter 15mm Tolerance 20%

Minimurm detected arc length 35 %

Alignment settings

Enable spiral search Spiral search area & mm
Always center fiducials for detection Settle time | 200 ms
Manual confirmation of fiducials Convert alignment to placement

Fig. 187: Dialog Alignment settings

Name Description

ROI configuration

Width (mm) The specified width is used for the search in the
camera pane. If this value is decreased,
measuring works faster. Large fiducials (larger
than 1 mm) incur the risk of not being recognized.

Height (mm) The specified height is used for the search in the
camera pane. If this value is decreased,
measuring works faster. Large fiducials (larger
than 1 mm) incur the risk of not being recognized.

Offset X (mm) Defines an offset in x direction.

Offset Y (mm) Defines an offset in y direction.

Fiducial criteria

Diameter Displays the allowed diameter of the fiducial.
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Name

Description

Tolerance

Indicates the allowed tolerance for the fiducial
search.

Minimum detected arc length

Indicates the minimum allowed arc length for the
fiducial search.

Alignment settings

Enable spiral search

Activates the spiral search within the alignment
settings.

Always center fiducials for detection

If this function is activated, the camera is
positioned above the center of the fiducial.

Manual confirmation of fiducials

If this function is activated, the position has to be
manually confirmed, after a fiducial is found.

Spiral search area

Determines the searching area for the spiral
search.

Settle time

Determines how long the system should wait after
a movement.

Convert alignment to placement

If this function is active, the alignment settings are
also applied in the dialog Placement.

Table 64: Dialog Alignment settings
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3.6.4 Material thickness measurement settings

The dialog Material thickness measurement settings contains functions for measuring
the material thickness and for defining the processing area.

Material thickness measurement settings -
Manual measurement can be started via the "Placement” menu.
[] Perform thickness measurement during process
Material thickness tolerance 100 pm
Min hole distance 2 mm
Measurement strategy ThreePoints hd
Referencing
Reference points X Y Z
Left rear 30,30 mm 217,00 mm --
Right rear 275,50 mm 217,00 mm --
Center 153,00 mm 132,50 mm --
Front left 30,30 mm 43,00 mm --
Front right 275,50 mm 48,00 mm -
Material thickness 0 mm
Old value Mew value Difference
Reference 0,00 mm -- --
Perfarm referencing
OK Cancel

Fig. 188: Dialog Material thickness measurement settings

Button/Element

Description

Perform thickness measurement during
process

Activates the material thickness measurement during
production. The material thickness measurement is
started by a work package of the type Instruction.
The option Material placement must be selected
here as instruction.

Material thickness tolerance

Specifies the permissible measurement deviation
from the specified material thickness. The lower the
tolerance, the longer the process time.

Min hole distance

Specifies the minimum hole spacing of the printed
circuit board. This ensures that the material thickness
measurement does not take place in a hole or other
depression of the material.

Measurement strategy

Sets the measurement strategy.

Measure three points: A total of three points are
measured

Measure five points: A total of five points are
measured
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Button/Element

Description

Measure one point per scan field: Each scan field
is measured separately with one point at a time.

Referencing

Left rear X, ¥, and z coordinates of the material at the left rear
corner.

Right rear X, ¥, and z coordinates of the material at the rear right
corner.

Center X, Y, and z coordinates of the material at the center.

Front left X, ¥, and z coordinates of the material at the front left
corner.

Front right X, ¥, and z coordinates of the material at the front

right corner.

Material thickness

Specifies the material thickness. If a material
template is used in the user guide step Material, the
value of the material thickness is automatically
entered.

Perform referencing

Starts the referencing of the processing area taking
into account the selected measuring strategy.
Referencing should always be carried out after
cleaning or replacing the sinter plate and after
transport to ensure the highest possible precision of
the system.

Table 65: Functions in the dialog Material thickness measurement settings

3.6.5 Process all

Starts the production of all processing data.

3.6.6 Stop processing
Stops the current production.
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3.6.7 Power measurement
Opens the dialog Power measurement.

Summary

The laser power of the system can be measured here.

Power measurement

Y |

Laser emission settings

Frequency [kHz] 50

Control value [%] 100

Internal power sensor settings

Position [mm] 10 705

Calib, offset 0

Calib. factor 1

Internal sensor power measurement

Power [W]

Close

Fig. 189: Dialog Power measurement

Name

Description

Laser emission settings

Frequency [kHz]

Defines the frequency for operating the laser.

Control value [%]

Defines the control value for operating the
laser.

Internal power sensor settings

Position [mm]

Displays the position of the laser power
sensor.

Calib. offset Displays the calibration offset of the laser
power measurement.
Calib. factor Displays the calibration factor of the laser

power measurement.

Internal sensor power measurement

Power [W]

Click on [Measure] to display the laser power
measured by the laser power sensor.

Powermap measurement

Starts the power measurement for creating a
powermap.

Table 66: Dialog Power measurement
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3.6.8 Laser beam diagnostics

Opens the dialog Laser diagnostics.

Summary

You can diagnose the laser beam here which includes a focus measurement and
determining the optimum cutting speed.

ZLero position
Last position
MNext position
Current position

Reset zero position

Material thickness valu

Laser diagnostics process position

Laser diagnostics

(10,00 mrm /295,00 mm])
(10,00 mrm /295,00 mm])
(13,00 mrn / 295,00 rim)

(153,00 ram / 289,00 mm)

Focus measurement

Cut the pattern

Coarse focus

Fine focus

Cutting speed
Cut the pattern

Cutting speed

Y
IMave to the next pasition . | b 4 | 2
e 0,52 mm
Estimated focus 7,000 mm
Measured focus --
Apply

Cutting speed -

QK Abbrechen

Fig. 190: Dialog Laser

The following settings are available:

diagnostics

Button

Description

Laser diagnostics process position

Reset zero position

Defines the current position as the zero position.

Move to the next position

Moves to the next position.

A

4 v >

Moves the processing head to the next/previous
position.

Material thickness value

Specifies the offset between the laser sensor and the
processing table. This value has been set correctly
already on delivery of the system.

Focus measurement

Cut the pattern

Activated: A test pattern is cut during focus
measurement. This is necessary for the first focus
measurement.
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Button

Description

Deactivated: The focus is measured with a test pattern
that was cut previously.

Coarse focus

Starts the coarse focus measurement. This requires
that a test pattern is cut first that is evaluated with the
vision system. The measured value is displayed in
Measured focus.

Fine focus

Starts the fine focus measurement. This requires that
a test pattern is cut first that is evaluated with the
vision system. The measured value is displayed in
Measured focus.

Astigmatism

Indicates the ratio between the x focus level and y
focus level of the laser beam. An astigmatism of = 0.2
mm indicates a technical problem with the system.

Apply

Applies the focus values determined with [Coarse
focus] and [Fine focus].

Cutting speed

Cut the pattern

Activated: A test pattern is cut when determining the
cutting speed. This is necessary when determining the
cutting speed for the first time.

Deactivated: The cutting speed is determined with a
test pattern that was cut previously.

Cutting speed

Determines the optimum cutting speed.

Table 67: Buttons and functions in the dialog Laser diagnostics
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3.6.9 Import/Export calibration settings
Opens a dialog for importing and exporting calibration settings.

Summary

Click on/Tap on [Import] to select a file from the file system to import calibration
settings.

Click on/Tap on [Export] to save the active calibration settings in the file system.

Import/Export.. - O

Import 3.x Calibration Settings

Impaort

Export 3.x Calibration Settings

Expaort

Clase

Fig. 191: Dialog Import/Export calibration settings
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3.6.10 Connect to machine...

Opens a dialog where you can connect the system software to a real or simulated
machine.

Summary
Select an appropriate machine from the list for connecting.
You can also simulate a virtual machine without having a real machine connected.

The dialog Connect is displayed when the connection between the software and the
system is established. The COM interfaces of the individual system components are
automatically scanned and connected when the connection is established. Select a
component from the list to display further information. You can start a new scan of the
COM interfaces by clicking on [Search components]. Clicking on [Create report]
creates a folder at

C:\ProgramData\LPKF Laser & Electronics\LPKF CircuitPro PL 3.5
\Config\Reports containing error details.

Connect

Some components could not be connected.

Motion system

- No electrical power

- Emergency shutdown button still pressed (for machines that have
Controller board one)

Laser
Scanner
Internal power meter

C) Startup Enabling laser - Update - 92%

Create report Cancel

Fig. 192: Automatic connection of the COM interfaces
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3.7 Menu Service

This menu contains password-protected menu items that are only available for the
LPKF Service.

Use the menu item Send support information to send an email with support
information to the LPKF Service.

Service

Maintenance schedule

Send support information

Fig. 193: Menu Service

The entries of the menu Service are described in the following table:

158/184

Name Description

Import settings from a Opens as dialog for importing settings from an old
previous version CircuitPro installation.

Opens a PDF file with maintenance steps to be

Maintenance schedule .
performed on a regular basis.

Sends an email with support information to the LPKF

Send support information Service.

Table 68: Menu Service

3.7.1 Import settings from a previous version

The menu item Import settings from a previous version allows you to import settings
from previous CircuitPro versions and CircuitMaster versions. You can import settings
from older CircuitPro PL versions automatically or select a folder of the file system
manually. This function can only be used if no machine is connected. So disconnect
the machine beforehand, if necessary (see Connect to machine...).

Importing powermaps from CircuitMaster 1.10 can cause errors if the Microsoft ACE
drivers (Access Database Engine) are not installed on the system.
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In case of errors, proceed as follows:

B Troubleshooting powermap import errors

1. Navigate to the program folder of CircuitPro PL (C:\Program Files\LPKF
Laser Electronics AG\LPKF CircuitPro PL
[version number]\Support Files\Runtime\AccessEngine).

2. Right-click on the application AccessDatabaseEngine X64.exe and create a
link.

Right-click on the newly created link and click on Propetrties.

In the tab Link, add the parameter /quiet in the line Target.

Start the link.

Once the installation has finished, retry importing the powermap.

o0~ w

| Troubleshooting of powermap import errors is finished.

3.7.2 Maintenance schedule

Displays the maintenance schedule of the system.

3.7.3 Send support information
Sends support information to the LPKF Service
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4

4.1

How to work with the software

The following pages provide information on the typical production process of the
system and the software.

Typical production process

This chapter describes a typical production process.

The following tasks are executed:

Starting the system software
Selecting a template

Selecting a material

Connecting the system software
Importing data

Assigning a technology to a layer
Multiplying the layout with Step and Repeat
Creating the fiducial manually
Creating a scan field set

Computing scan fields automatically
Editing tools and tasks

Editing a work package

Setting the dynamic alignment
Computing toolpaths

Saving the project

Starting the production

Stopping processing (optional)
Closing the system software
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B Starting the system software

1. Double-click on the desktop icon of CircuitPro PL.

LPEF CircuitPro PL
[Wersion Mo.]

Fig. 194: Desktop icon CircuitPro PL

2. Wait while the system connection is established.

System connection -

Connecting..

Fig. 195: Message System connection

3. The system software automatically detects the connected system and establishes
a connection. The following dialog is displayed:

Signal light check

0 Check whether all signal lights are switched on.
Are the red, yellow, and green signal lights lit?

Yes ' No

Fig. 196: Dialog Signal light check

4. If all specified lamps of the stack light are lit, click on [Yes].
O The user interface of the system software is displayed:

LPKF CircuitPro PL 2019.1 - Advanced edition - Untitled[S4_SingleSided_Top] - g
File Edit Insert Layout Toolpaths Processing Service
H A
Workflow setup 1 - -
New Material Import Layout Scanfields Tools Workflow Toolpaths Processing Camera
4 Material

b == FR4 1.5 mm 18 um
» Layout Recent projects ————— | All materials [¥] [ Aimachinetypss [¥] [ Supported by Protobst
b Scan fields
I Tools

b Workflow
b Toolpaths
b Processing

~ | | PcB with Top layer, prepared for Protolaser 54

u Pl
+/ Single-sided, Top, Protolaser S4

Doubl | ,
Double-sided, ProtoLaser $4, ProConduct
4 Layers, ProtoLaser S4, gelvanic through-hole pleting

Open project..

Recent ter

tes
S SingleSided Top 4 Layers, ProtoLaser 4, galvanic through-hole plating, MultiPress §

4 Layers, Protolaser S4, ProConduct
4 Layers, Protolaser S4, ProConduct, MultiPress S

6 Layers, Protolaser S4, gelvanic through-hole pleting

6 Layers, ProtoLaser S4, galvanic through-hole plating, MultiPress §
8 Layers, ProtoLaser S4, galvanic through-hole plating

8 Layers, ProtoLaser S4, galvanic through-hole plating, MultiPress §
Stencil for ProtoPrint, A4 for QR 266 x 380, ProtoLaser 54
ProMask_Removal, ProtoLaser S4

4 Layers, ProtoLaser S4, galvanic through-hole plating, MultiPress §
6 Layers, ProtoLaser S4, galvanic through-hole plating, MultiPress §
8 Layers, ProtoLaser S4, galvanic through-hole plating, MultiPress §
Single-sided, Top, ProtoLaser U4

Single-sided, Bottor, ProtoLaser U4 .

Load template Material >

Fig. 197: User interface CircuitPro PL

V] The system software has been started.
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. Connecting the system manually

If the connection to the system fails, you can manually connect the system to the
system software.

1.
2.
3.

Click on Processing > Connect to machine...
Select your system from the drop-down list.
Click on [Connect].

The system requires a warm-up time of approx. 20 minutes for the laser source to
attain a constant diode temperature. The warm-up phase starts automatically with
the processing of the first job.

Alternatively, you can start the warm-up phase manually. In the Processing view,

click on

—_

2.
O

Selecting a template

Select the suitable template for your project.

You can filter the templates by machine type and PCB type (single-sided, double-
sided and multi layer) to determine a suitable template.

Click on [Load template].
The system software navigates to the user guidance step Material.

|Zl The template has been selected.
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B Selecting a material

1. In the user guidance step Material click on a material template or define a new

LPKF CircuitPro PL 2019.1 - Advanced edition - Untitled[S4_SingleSided_Top] - g
File Edit Insert Layout Toolpaths Processing Senice

Workflow setup » | N Material

Material composition _
Y e == Alle Materialien iG] BN
» Scan fields

[Tk} i Material name FR4

Tools Einseitig, 15 mm, 18 pm
I Workflow R4 Total thickness
3 TOOIPE‘I\S Einseitig 15 mm, 35 um Treat as non-laminated
1> Processing FR4

FR4 Copper

Doppelseitig, 1,5 mem, 18/18um
Core
FRA
Doppelseitig, 1,5 mm, 35/35um
FRA
Doppelseitig, 1,5 mm, 5/5um

< ten
Fig. 198: User guidance step Material

2. If necessary, make changes to the material settings.
3. Click on [Select material] to confirm the selected material.

|Z[ The material has been selected.

' Selecting a material type

When selecting the Material, you also select the tool library with the laser parameters
specific to the material.

B Connecting the system software

1. Click on/Tap on Processing > Connect to machine...
O The following dialog is displayed:

Connect to machine = =
Select the machine to be connected b

[Jisimulate machine
Connect Cancel

Fig. 199: Dialog Connect to machine

2. Select your system in the drop-down list.
3. Click on/Tap on [Connect].
4. Wait until the process is completed.

V] The system software has been connected.
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Once connected, you can set the options in Machine that the software shall connect
automatically. Activate the check box Simulate machine to simulate the complete

workflow. You can use this mode to create projects or to practice using the software
without connection to a machine.

B Importing data

1. Open the user guidance step Import.

2. Click on [

3. Select the files to be imported.

4. Click on [Open].

O The following contents are displayed, according to your imported file.

New Material Import Layout Scanfields Tools Workflow Toolpaths  Processing Camera
I Tutor.808 [ caberx []| zosranpe s
i == = |SeefFermnat b | e =

| ¥ BoardOutiine [ Boardoutline [v]a0g32x4572 mm \ Values

E Tutor.80T [ Gerberx [¥] [Botape Decimal

[saurce [Targer [se/Formar [
) \ o= || = | liee | B |

Fig. 200: User guidance step Import

O The tab 2D displays the preview of the imported data.

You can assign an existing project layer to the layers of the file in Target.
5. Click on [Import].

|Z[ The data have been imported.
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B Assigning a technology to a layer

1.

Right-click on a layer in the pane Workflow setup.

O The following context menu is displayed:

V. 1.1 | LPKF Laser & Electronics AG

Color...
v Visible
+  Selectable
PCE layer »
Display mode
Technology * W Mechanical
Inverse Fiducials
Rename Drilling
Delete Cutting
Wiring
Rubout
Solder mask
Solder paste
Silk screen
Topography
Information
Unknown
Fig. 201: Context menu Layer

2.
VI The technology has been assigned to the layer.

In the menu item Technology, click on an entry.

The assigned technology determines to which work package a layer can be assigned

to and also which scan fields and tools are used.
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B Multiplying the layout with Step and Repeat
1. Select the object to be multiplied.

Fig. 202: Selecting the object

2. Right-click on any position inside the user guidance step Layout.
O The context menu is displayed.

3. Click on/Tap on Step and Repeat.

O The following dialog is displayed:

Step and repeat

C::uuntx| ‘_| }‘| 1|

?'EEap distance

X 0,000 mm i
y
y 0,000 mm R

1 Offset

Preview

[] Combine to flash list

| QK || Cancel |

Fig. 203: Dialog Step and Repeat

4. Inthe fields x and y in Count enter the count for the multiplications of the selected
object.

5. Inthe fields x and y in Distance enter the distance between the center points of
the objects to be created.

The preset distance is defined by the height and width of the selected object. Using
unchanged settings, the new objects are created side by side without a gap. Increase
the value in the fields x and y to generate a gap between the created objects.
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6. Click on/Tap on [OK].
O The selected object is multiplied.

Fig. 204: Multiplied object

V] The layout has been multiplied with Step and Repeat.

Creating the fiducial manually

Navigate to the user guidance step Layout.

Click on Insert > Fiducial.

The mouse cursor is displayed as crosshairs.

Click on the position in the layout where the fiducial is to be inserted.

Enter an x and y value for positioning the fiducial.

Right-click in the layout to open the context menu.

In the context menu click on Cancel after all fiducials have been set in the layout.

In the pane Workflow setup in the area Layout > Fiducials the fiducial is displayed
and assigned to the layer Fiducial.

Ooo»>®Ond = @

|Z[ The fiducial has been created manually.

Scan field sets

Scan field sets define which positions of the material are processed in which order.
They can be defined for one or more layers and are combined in work packages with
the corresponding tools.

The individual scan fields are combined to scan field sets, the numbering indicates
the direction of the processing head’s movement. This order can be adapted
automatically or manually in order to configure the production as efficient as possible.
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B Creating a scan field set

Open the user guidance step Scan fields.
Click on/Tap on [F%.

Enter the name for the scan field set.

Activate the check boxes of the desired layers.

Creating a new scan field set

oD~

Mame |Scanfield set 1 |

Layers | ™1 [7] Fiducial A
][] BoardOutline
C1 [ cutinside
[] [ DrillPlated v

Cancel

Fig. 205: Dialog Creating a new scan field set
5. Click on/Tap on [Create].

[Zl The scan field set has been created.
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B Computing scan fields automatically

1. Open in the pane Workflow setup the context menu with a right-click on Scan
fields.

2. Select a scan field set in the drop-down list Scan field set, if necessary.

Click on E. Compute.

O The following dialog is displayed:

Compute scan fields

w

Scan fields set Top Side scan field set | v
Size ¥ | 1,96%9in | ¥ | 1,969 in
Safemargin = x | 0197in | ¥ | 0,197in

[ ] Without overlap

Overlap X | 01%7in | ¥ | 0197 in

v

Without scan field offset

Fig. 206: Dialog Compute scan fields

4. Enter the parameters:

Name Description

Scan field set Specifies the name of the scan field to be computed.

Size Defines the size of the computed scan fields.

Safe margin Defines a margin between the data inside the scan field and the edge

of the scan field. If the value is 0 the data can be placed right to the
edge of the scan field.

Without overlap Deactivates the overlap of scan fields in x and/or y direction.
Overlap Defines how far the scan fields overlap each other.

Without scan field Specifies the isolation distance between the scan fields.
offset

Offset Specifies the offset between the scan fields.

Table 69: Dialog Compute scan fields

5. Click on [Compute].

[Vl The scan fields have been computed automatically.

After creating the scan fields, you can sort the order automatically or manually which
changes the processing order.
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The preset tools are suited for processing sample files. You should use new tools with
optimized parameters for your own data.

In the user guidance step Tools, you can create new tools or tasks and edit existing
tools or tasks. The tasks and their parameters define the laser settings that are used
for processing the material.

Editing tools and tasks

H
1. Open the user guidance step Tools.
2. Select a task or create a new task.
3. Set the parameters of the task.

Click on E5 to create more tasks.

Click on EE to copy a task.
4. Once the parameters are correctly set, click on [Apply].

|Z[ The tools and tasks have been edited.

Work packages

The work packages combine various information such as layers, tools, scan fields,
and technology and enable computing the toolpaths.

There are predefined work packages that already use the existing layers, tools and
scan fields. If you are using customized data for your own layout, you should edit the
work packages or create new ones.

B Editing a work package

1. Open the user guidance step Workflow.
2. Click on a work package.

Work package options
Activated
Marme Work packagel
Type Drilling v
Tool . Drilling teol Expose Fiducials | v
Input layer [] Drill Small Holes  ~
B Drill Medium Ho...
B il Big holes
. Expose Fiducials
'_| Nl DL i A
Scan field set Commen scan fields v
Scan field order [ ] Descending

Fig. 207: Area Work package options

3. Select the type.
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The selected type defines which layers can be processed in this work package
and which tools may be used. A package of the type Drilling can only process
layers of the technology Drilling.

4. Select the layers to be processed.
Some types do not require assigned layers.
5. Select a tool.
Some types do not require assigned tools.
Only tools that are suited for the selected type are displayed.
6. Select a scan field set.
Some types do not require an assigned scan field set.
7. Click on [Apply].

|Zl The work package has been edited.

You can create new work packages by clicking on [_]. After that, you can change the
options of the new work packages.

LPKF recommends to use at least two fiducials to be able to determine exactly the
position and rotation of the PCB.

Setting the dynamic alignment

Click on/Tap on the user guidance step Workflow.
Click on/Tap on a work package of the type Read fiducials.
The following dialog is displayed:

o™= J

Work package options
Activated

Mame Work package "Read Fiducials"
Type Read fiducials v
Scan field set

Scen field order [] Descending

Dynamic alignment

<No fiducial> | ¥
<No fiducial> | v
<Mo fiducial> | ¥

<No fiducial> | ¥

Fig. 208: Function Dynamic alignment

3. Inthe fields of the area Dynamic alignment select your fiducials.
4. Depending on the number of fiducials, different adjustment options are available.

LPKF recommends to use at least two fiducials to be able to determine exactly the
position and rotation of the PCB.

5. Click on/Tap on [Save].

[Vl The function Dynamic alignment has been set.
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B Computing toolpaths

1. Click on Toolpaths > Compute all... or in the user guidance step Toolpaths on 7.

Toolpaths |

il Compute all...

Edit breakout tabs...

Fig. 209: Menu Toolpaths

O The toolpaths are computed.
2. Wait until computing is finished.

Toolpaths calculation =

Calculation of toolpaths is in progress. Please wait...

Fig. 210: Message Computing toolpaths

O A message displays the computation results.
3. Click on [Close].

|Z[ The toolpaths have been computed.

You can have the toolpaths displayed by clicking in the user guidance step Toolpaths
on ::.
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B saving the project

1. Click on File > Save as...

File

D Mew... Strg+M
Open... Strg+0

EH save Strg+5

EZ Savess.

[ Export. Strg+E

& Print. Strg+P

[&  Print Preview.. Strg+F2

Info b
Help... F1

Options...

€ Exit

Fig. 211: Menu File

2. Select the location and the file name for the project.
3. Click on [Save].

VI The project has been saved.

The system requires a warm-up time of approx. 20 minutes for the laser source to
attain a constant diode temperature. The warm-up phase starts automatically with the
processing of the first job. As an alternative, the warm-up phase can be previously
activated via a function in the menu Processing.

B Sstarting the production

1. Click on Processing > Process all or in the user guidance step Processing on p-.
2. Follow the instructions on your screen.

V] The production has been started.

B Stopping processing (optional)

» Click on/Tap on Production > Stopping processing or click in the user guidance
step Processing on M .

M Processing has been stopped.
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B Closing the system software

1. In the menu File click/tap on Close.

2. The following message is displayed:

Save document

Current document was modified. 5ave changes?

[l Cancel

Fig. 212: Dialog Save document

3. Select one of the following options:
[Yes] to save all changes in the document.
[No] to discard all changes since the last save.
[Cancel] to continue using the system software.

|Z[ The system software has been closed.
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